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1. Introduction to setting up Retail
Footwear and Apparel
Managers, designers, librarians, and other stakeholders in the retail industry use the Retail Footwear and
Apparel solution to create and manage their retail products at the various stages in the product lifecycle.

As an administrator, you must perform the following tasks to set up Retail Footwear and Apparel:

• Set up line plan views to personalize or share the grouped and filtered data based on business needs.

• Create roles, and groups for Retail Footwear and Apparel users.
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• Define schedules and workflow templates that are used to define the milestones, phases, and tasks for
the retail products.

• Manage vendor information identified for manufacturing the retail products, and establishing a
vendor security model.

• Create a list of dimension vales.

• Configure image compression to compress images displayed in various cases such as search results,
BOM, and techpacks. This helps optimize the size of the data and improves overall performance.

• Configure the Help tile link to access user help for Retail Footwear and Apparel.

1. Introduction to setting up Retail Footwear and Apparel
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2. Managing Retail Footwear and Apparel
users
About predefined groups, roles, and users

As an administrator, you create user profiles with different roles, who form the user base of Retail
Footwear and Apparel. These users create retail products, delete them, and manage the access control
list as needed. Some of the most common user roles in Retail Footwear and Apparel include:

• Product manager

• Trim librarian

• Designer

• Technical designer

• Color librarian

• Sourcing manager

• Merchandising manager

You can also create groups of users and add the roles and users to these groups.

Retail Footwear and Apparel provides the following groups and roles out of the box.

Group Roles

Buyer Analyst

Director

Manager

Fabric Approver

Manager

Merchandising Buyer

Packaging and Labeling Analyst

Director

Manager
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Group Roles

Partner Product sample manager

Product Development Analyst

Director

Manager

Quality Assurance Analyst

Director

Manager

Simulation Administration Override approver

Simulation administrator

Validation Administration Override approver

Validation administrator

The workflows in Retail Footwear and Apparel are designed for the following groups and roles:

Group Role

Engineering Designer

Engineering Technical designer

Product Development Manager

For more information about how to create a user in Active Workspace, see the Deployment
and Configuration→Configuration and Extensibility→Administration→Managing groups, roles, and
users→Create a user topic in the Active Workspace help.

Managing groups, roles, and users

Creating the organizational structure

By setting up user management you can control the functionality that is available to users who are
mapped to a specific role, thereby controlling the access to restricted data. To do this, you can create
groups for specific projects, and add users, or roles assigned as team members to the projects.

Example:

You want to set up the organizational structure for a project that requires an administrator, a
project manager, two designers, and two analysts. You first create a project and add a group to the

2. Managing Retail Footwear and Apparel users

2-2  Retail Footwear and Apparel ─ Administration, Teamcenter 2412
© 2025 Siemens



project. You then identify the users or create new users that you require for your project. Next, you
search for existing roles or create new roles required for the project. You then add the roles to the
group, and add users to the respective roles in the group.

Creating the organizational structure
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Managing users, groups, and roles

Understanding groups, roles, users, projects, and data access

Groups

A group is a named set of users who share one or more specific types of work in common, and
who have the same access permissions for data and locations. Groups may be synchronized with the
company's user authentication system. Users may be assigned to more than one group. Groups can be
created to represent data ownership and to control data access. Projects are created with specific groups,
users, or roles assigned as team members, privileged team members, and team administrators.

Typically, groups are defined along project lines and not functional lines. However, you can also create
groups of third-party organizations such as suppliers.

A group member can be a member of multiple groups. Groups make up the core of the organization
structure.

As an administrator, you can:

• Create and modify groups.

Note:

You must use the Teamcenter rich client to remove or delete a group or subgroup from the
parent group, as this capability is not available using the Active Workspace client.

Example:

The high_performance group consists of 2 roles, that is, Engineering Manager and Standards
Engineer, and 2 users, namely, rgreen and mread, who are assigned their respective roles.

• Assign authorized data access privileges to a group.

2. Managing Retail Footwear and Apparel users
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• Assign default volumes to a group.

A volume is a location where files are stored. A volume corresponds to a directory on the operating
system. Files stored in volumes are created by CAD applications or other third-party applications. You
can assign volumes to groups and define file locations for your organization structure.

• Manage subgroups within the organization.

A subgroup is a group with another group designated as its parent. A subgroup may also be
designated as a parent group. The position of subgroups within the organizational hierarchy can
be managed by parenting and reparenting groups.

Subgroups can be used to organize users. Subgroups inherit access permissions, volumes, and
preferences from their parent.

Example:

Consider a scenario where you wish to restrict contractors from viewing any content in the
employee group. In this case, you can create subgroups abc and acme within a group such that
users from these subgroups will not have access to the content from any groups other than their
own.

Roles

A role defines a specific job function within a group. Roles are attached to groups and users are assigned
to one or more roles within a group.

• A role can be assigned to multiple groups.

• Roles add an additional layer of data access control.

• Roles are created along functional lines.

Understanding groups, roles, users, projects, and data access
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Tip:

While creating roles, use real-world descriptions, skills, and responsibilities.

As an administrator, you can:

• Create, modify, and delete role definitions.

• Add new or existing roles to groups.

• Assign a default role within a group.

Example:

Robert Green, a user, is assigned the default role of Engineering Manager. In addition to
his responsibilities as engineering manager, Robert must also perform standards-related work.
Therefore, user rgreen is assigned two roles in the high_performance group: Engineering
Manager and Standards Engineer.

Users

Users are individuals who interact with Active Workspace. A user is assigned to a default group and takes
on a role in the group.

As an administrator, you can:

• Create, modify, deactivate user accounts, or delete users from groups.

• Reset user passwords.

• Assign license bundles, and license servers to a user.

2. Managing Retail Footwear and Apparel users
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When you assign a license bundle to a specific user, the user assigned to the bundle is assured
the availability of all the features in the bundle. You can use license bundling in conjunction with
other licensing schemes. Consider a scenario where a user is assigned a license bundle that does not
include the Systems Engineering module. When the user launches Systems Engineering, the system
confirms if the feature key exists in the license file outside of the license bundle. If the feature key is
found, the application can be used.

A license server is a process dedicated to tracking license usage by users. It runs on a host machine
and port specified by an administrator. An administrator can set up multiple license servers. Each
license server can have a different set of users assigned to it. This allows the load balancing of license
requests so that a single license server is not overused.

Users can be assigned various roles in the organization. A user can also be part of multiple groups in the
organization.

Example:

Robert Green, a user, is assigned the default role of Standards Engineer and belongs to the
default group high_performance.

Projects

Projects provide a means to associate data and users from different groups, such as Engineering,
Supplier, and Customers, and allow configuration of access rules based on this association. This is
an easy way to organize your data and implement the access control based on a business project or
program's security requirements.

You can use the PROJECTS tile to create projects and programs and manage your project teams by
correlating groups of users, potentially at different physical sites, with your product data. However, you
must use the rich client to delete projects.

Example:

A project comprises a group of users each having one or more roles. For example, this project
consists of an administrator, a project manager, two designers, and two analysts.

Understanding groups, roles, users, projects, and data access
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There are several measures you can use to control access to your project data:

• When creating a project, you can use the Project Category field, which allows you to restrict a user's
access to objects based on the category of the project. For example, a user assigned to the Supplier
project category would be unable to view proprietary information. The default project categories are
Internal, Partner, and Supplier.

• Designating team members as privileged is one step in the process of granting access to users to
allow them to assign data to and remove data from projects and programs.

Controlling data access

In addition to licensing and authentication, another way to control information access for users, both
internal and external, is by configuring Access Manager rules and access control lists (ACLs). These rules
and lists control access by user, group, role, organization, and workspace.

Managing groups, roles, and users in Active Workspace

In Active Workspace, you can use the PEOPLE location to create and modify users, roles, and groups and
to set up authorized access using login credentials for each user.

The PEOPLE tile is visible in both the Active Admin and Default workspaces.

2. Managing Retail Footwear and Apparel users
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You can create your own workspace mapped to a special group of non-dba group users and add the
PEOPLE tile to it. This allows users to perform admin work because privileges for dba group users are
too broad.

As a database administrator, you can create users and user roles specific to your organization. You can
then add the users and roles to a specific group to grant them authorized access to the application.

By default, your organization's groups, users and roles are listed on the Organization page in Tree view.

• Click Tree to change to other views.

• Right-click on objects for quick access to actions you can perform.

• Click Selection Mode or Ctrl-click on objects to select more than one object.

Creating and managing groups, roles, and users

Managing groups, roles, and users in Active Workspace

In Active Workspace, you can use the PEOPLE location to create and modify users, roles, and groups and
to set up authorized access using login credentials for each user.

The PEOPLE tile is visible in both the Active Admin and Default workspaces.

You can create your own workspace mapped to a special group of non-dba group users and add the
PEOPLE tile to it. This allows users to perform admin work because privileges for dba group users are
too broad.

As a database administrator, you can create users and user roles specific to your organization. You can
then add the users and roles to a specific group to grant them authorized access to the application.

By default, your organization's groups, users and roles are listed on the Organization page in Tree view.

• Click Tree to change to other views.

• Right-click on objects for quick access to actions you can perform.

• Click Selection Mode or Ctrl-click on objects to select more than one object.

Create groups

You can use the People location to create groups. To create your group at the organization level, first
select Organization in the Tree view. To create a group within a group, first select that group using any
view.

1. Perform one of the following steps:

Managing groups, roles, and users in Active Workspace
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• On the Organization page, click Add  > Add Group .

• On the Organization page, right-click on Organization (Tree view only) or another parent group
and click Add Group .

• On the Groups page, click More commands  > New  > Add .

The Add panel appears.

Tip:

To keep the Add panel open so that you can continue to add groups without opening the
panel each time, click Pin Panel .

2. To add an existing group, use Search to search for the group.

To create a new group, use New to specify the following values.

• Name

Specify a name that is not the same as the new group's parent or sibling groups.

• (Optional) Description

• (Optional) Security

• (Optional) To Parent

To create a subgroup for an existing group, select the parent group from the list. By default, the
parent is the group selected at the time the new group is created.

• (Optional) DBA Privilege

• (Optional) Default Volume

• (Optional) Default Local Volume

3. Click Add.

Create and add roles to groups

You can use the People location to create and add roles to groups.

1. Perform one of the following steps:

• On the Organization page, select one or more groups and click Add  > Add Role .

2. Managing Retail Footwear and Apparel users
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• On the Organization page, select one or more groups, right-click and click Add Role .

• On the Groups page, select a group and click Add Role  in the Roles section.

The Add panel appears.

2. To add an existing role, use Search to search for the role.

To create a new role, use New to name and describe the role.

3. Click Add.

Create and add users to roles

You can use the People location to create and add users to roles.

1. On the Users page, click More commands  > New  > Add .

2. In the Add panel, in the New section, enter the following:

• Name

• User ID

• OS Name

• Default Group

• (Optional) Default Volume

• (Optional) Default Local Volume

• Status

To create an active user, set Status = 0.

• License Level

The types of licenses available depends on your license agreement. For descriptions of the
available license levels, see your license agreement documentation.

• (Optional) License Server

• (Optional) License Bundle

• Visualization Licensing Level

Create and add users to roles
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0 (Base)

1 (Standard)

2 (Professional)

3 (Mockup)

• (Optional) Geography

• (Optional) Nationality

• (Optional) Citizenships

In the Personal Information section, specify any of the optional fields:

3. Click Add.

Managing users

Edit user information

You can use the People location to edit user information.

1. Navigate to the Users tab and search for an existing user. Select the user.

2. Click Edit .

3. Modify the user information and click Save .

Alternately, select the user on the Organization tab and click Edit  to update user information and
other properties.

View user activity logs

Audit logs must be enabled for users other than those in the dba group.

1. In the Roles page, select the role for which you want to view the user activity logs.

2. Click the Audit Logs tab.

A table that shows the Logged Date, the Event Type Name, and the Login User ID is displayed
under Organization Logs.

2. Managing Retail Footwear and Apparel users
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Viewing user access rights

The Access tab enables you to view access rights on objects in Active Workspace. As an administrator,
it helps you determine if the correct access privileges have been assigned to the selected user. If a user
is assigned multiple groups and roles, you can determine access for that user by selecting a particular
group/role combination and clicking Show Access Rights.

The Access tab contains three sections:

• User, Group, and Role filters

Filters the user, group, and role for the current user session context.

You can use these filters to select another user, group, and role combination for which you want to
view the associated access rights for the currently selected object. Click Show Access Rights to apply
these changes.

• Access Rights

Lists the operations and privileges granted to the filtered combination of user, group, and role.

• Associated Rules

Lists the rules associated with the given object.

Note:

By default, the Access tab is not available. To add the Access tab, edit the style sheet registered
to the summary view for the object type to which you wish to add the Access tab.

Example:

Viewing user access rights
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Ed, a designer in the engineering group, designed the testItem object. His access rights are shown in
the Access Rights section. Ed is granted Read, Write, Delete, and other rights because he is the owning
user.

Add the Access tab to view user access rights

The Access tab enables you to view access rights on objects in Active Workspace.

By default, the Access tab is not available. To add the Access tab, edit the style sheet registered to the
summary view for the object type to which you wish to add the Access tab.

1. Open the style sheet registered to the summary view for the type of object to which you wish to
add the Access tab:

• Item revision

The default summary style sheet is Awp0ItemRevSummary.

• Document revision

The default summary style sheet is Awp0IDocumentRevSummary.

2. Managing Retail Footwear and Apparel users
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• Requirements revision

The default summary style sheet is Awp0RequirementRevisionSummary.

2. Add the following line to the appropriate style sheet.

<inject type="dataset" src="Aut0ItemRevSummary" />

a. For an item revision, add the line here in the Awp0ItemRevSummary style sheet:

<inject type="dataset" src="Fsh1FinishesSection"/>
<inject type="dataset" src="Ads1NotesSection"/>
<inject type="dataset" src="Vm1PartnerContracts"/>
<inject type="preference" src="ClassificationStylesheetTab"/>
<inject type="dataset" src="Sm1MadeFromSection"/>
<inject type="dataset" src="Aut0ItemRevSummary"/>

b. For a document revision, add the line here in the Awp0IDocumentRevSummary style sheet:

<inject type="dataset" src="Fnd0ClassificationSummary"/>
<inject type="dataset" src="ProjectListInfo"/>
<inject type="dataset" src="Aut0ItemRevSummary"/>

c. For a requirements revision, add the line here in the Awp0RequirementRevisionSummary
style sheet:

<inject type="dataset" src="WorkflowSummary"/>
<inject type="dataset" src="RelationsSummary"/>
<inject type="dataset" src="Ase0SystemRequirementsSubLocation"/>
<inject type="dataset" src="Aut0ItemRevSummary"/>

Add or change a user password

You can use the People location to change a user password.

1. In the Users page, select the user whose password you want to add or change.

2. Click More commands  > Manage  > Change Password .

3. In the Change Password panel, specify and confirm the new password.

4. Click Change.

Add or change a user password
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Deactivate users

You can deactivate a specific user ID by modifying the status of the user in the People location. This user
is retained in the database and can be activated for future use.

Example:

Consider a designer who will be going on an extended leave of absence. Instead of deleting the
user from the project group, you can temporarily deactivate the user. Once the user is available,
you can set the status to active.

1. On the Organization page, search for the user whose status you want to modify and select the
user.

2. Click Edit  to display the properties and other settings that a can be updated for the user.

3. In the Properties section, set the Status field of the user to 1 Inactive.

4. Click Save .

Delete a user from a group

You can use the People location to delete a user from a group.

1. In the Organization page, using the tree view, search for the group from which you want to delete
a user.

2. Expand the group to show the roles in the group.

3. Expand the role containing the user you wish to remove from the group.

4. Select the user and click Remove .

Alternately, select the user, right-click, and chose Remove .

Managing roles

Edit a role

You can use the People location to edit the properties of a role.

1. On the Roles page, search for the role you which to edit. Click on the role.

2. Click Edit  to enable editing of the role's properties.

3. Modify the role name and description.

2. Managing Retail Footwear and Apparel users
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4. Click Save .

Delete a role

You can use the People location to delete a role. However, you cannot delete a role that is referenced by
another organization object.

1. In the Organization page, using the tree view, search for the group from which you want to delete
a role.

2. Expand the group to show the roles in the group.

3. Select the role and click Remove .

Alternately, select the role, right-click, and chose Remove .

Delete a role
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3. Setting up line plan views and importing
HTS codes
Configure the grouping of line assortment plans

You can configure the Ret0RetailLinePlanUsage business object to group the line assortment plans
according to costs or quantity. You can also create new attributes and specify a formula to display the
rolled up cost of retail products.

1. Log on to BMIDE using your dba account.

2. Search for and open the Ret0InternalGroup business object.

3. Add a persistent property to the Ret0InternalGroup.

a. In the Properties tab, click Add.

b. In the New Property dialog box, select Persistent, click Next, and enter the property details.

c. Specify values for Name, Display Name, Description, and Attribute Type.

d. If the Nulls Allowed check box is not selected, select it and click Finish.

4. Open the Ret0RetailLinePlanUsage business object and add a compound property.

a. In the Properties tab, click Add.

b. In the New Property dialog box, select Compound and click Next and enter the property
details.

c. Specify values for Name, Display Name, and Description.

d. Click Add Segment.

e. In the Add Compound Property Segment dialog box, select the typed reference property
ret0InternalGroup, and click Next.

f. Select the Ret0InternalGroup business object and click Finish.

g. In Path, select the Ret0InternalGroup business object and click Add Final Segment.

h. In the Add Compound Property Segment dialog box, select the re0Mix persistent property
and click Finish.
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i. Click Finish to define the compound property. Ensure that you do not select the Read Only
check box so that users can modify the property that you defined.

5. Open RetailLinePlanUsageGroup and add a runtime property.

a. In the Properties tab, click Add.

b. In the New Property dialog box, select Runtime, click Next and enter the property details.

c. Click Finish to add the property.

6. Specify the property constants for the RetailLinePlanUsageGroup.

a. In the RetailLinePlanUsageGroup business object, click the Property Constants tab and
open the Ret0RetailLinePlanGroupToUsage property.

b. In the Property Constant dialog box, in the Value box, specify the internal name of the
property that resides on Ret0RetailLinePlanGroup. In this example, the name of this property
is the ret0Mix.

7. Specify the value of Ret0RollUpFormula property.

a. In the RetailLinePlanUsageGroup business object, click the Property Constants tab and
open the Ret0RollUpFormula property.

b. In the Property Constant dialog box, in the Value box, specify the formula. You can specify
the value as Sum, Average, or Weighted Average.

8. Save your changes and deploy the data model.

Customize the display of dimensions in the line assortment plan

By default, the Size and POM Variant dimensions are displayed in the line assortment plan. You
can also add any dimension available for the retail product to be displayed in the line assortment
plan view. To do this, you must perform certain configurations in BMIDE and then set the
RETAIL_lineplanusageproperty_vs_dimensionname_map preference.

1. To add the dimension as a property to Ret0ExternalGroup:

a. Open BMIDE and search for Ret0ExternalGroup.

b. Choose Properties tab → Add.

c. In the New property dialog box, select Persistent and click Next.

d. Specify values for Name, Display Name, Description, and String Length, and click Finish.

3. Setting up line plan views and importing HTS codes
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2. Add a compound property to the RetailLinePlanUsage object. This compound property represents
the dimension that you added to the ret0ExternalGroup group in Step 1.

Customize the display of dimensions in the line assortment plan
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In this example, add ret0Length, the property added, represents the ret0Length property of
ret0ExternalGroup.

a. Select RetailLinePlanUsage and choose Properties tab → Add.

b. In the New property dialog box, select Compound and click Next.

c. Specify values for Name, Display Name, Description, and Path, and click Finish.

3. Setting up line plan views and importing HTS codes
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d. Save your work and package the template.

3. Set the preference to display the dimension in the line assortment plan.

Customize the display of dimensions in the line assortment plan
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a. In the rich client, choose Edit → Options, and in the Options dialog box, click Search.

b. In the Preferences List, in the Search on Keywords box, search for the
RETAIL_lineplanusageproperty_vs_dimensionname_map preference and double-click to
view it.

c. In the Definition tab, under Values, click Edit to enter the property name of the dimension in
the <property_name>:<dimension_name> format.

In this example, you enter ret0Length:Length as the property name.

d. Click Save.

4. Add the newly added dimension name in the retailUiConfigCots.xml file. This file, which lets you
specify the column configuration, is located at ${TC_INSTALL_DIR}/ret1retailaw/data.

a. Open the retailUiConfigCots.xml file and add the following entry under tags:

ColumnConfig columnConfigId="lineplanDefaultView" and 
ColumnConfig columnConfigId="lineplanAllColumnView"

For example:

<ColumnDef objectType="Ret0RetailLinePlanUsage" 
propertyName="ret0Length" width="150"/>

3. Setting up line plan views and importing HTS codes
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b. Run the following command on the Teamcenter command prompt:

import_uiconfig -u=Tc-admin-user -p=password 
-g=group -for_group=<group_name> -for_role=<role_name> 
-file=${TC_INSTALL_DIR}/ret1retailaw/data/retailUiConfigCots.xml

Where group_name is the appropriate group name and role_name is appropriate role
name.

For example:

import_uiconfig -u=Tc-admin-user -p=password -g=group 
-for_group="Engineering" -for_role="Designer" 
-file=C:\apps\tc\tc112\TR\install\ret1retailaw\data\retailUiConfi
gCots.xml

Along with the default Size and POM Variant dimensions, users can now see the newly added
dimension in the line assortment plan.

Setting up line assortment plan views

About line plan assortment views

Line assortment plan views let users group and filter data in their line plans. To enable users of Retail
Footwear and Apparel to group and filter data in their line plans, system administrators must first create
these views using TcXML Import.

Prerequisites for creating line assortment plan views

Ensure that the RetailLinePlanViewImportOptionSetDefault transfer option set is imported from the
out of the box samples. If not, import using the following command:

tcxml_import -u=<user> -p=<password> -g=<group>
-file=TC_DATA\RetailSamples\OperatingSystem\samples\retail_TechpackOptionSets.xml
-scope_rules-scope_rules_mode=overwrite

Set up retail line assortment plan views

To set up line assortment plan views, you must first create the sample_view.xml file and import it to the
location where you have saved the retail kit.

About line plan assortment views
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Create a new view.xml file

1. Create a new view.xml file as specified in the TC_DATA/RetailSamples/OperatingSystem/
samples/lineplanviews/Default_View.xsd and TC_DATA/RetailSamples/OperatingSystem/samples/
lineplanviews/Sample_View.xml files.

2. Save your file in a folder where you have write access.

Import the view.xml file

1. Open the Default_View.xsl file located at TC_DATA/RetailSamples/OperatingSystem/samples/
lineplanviews/Default_View.xsl and update the site_identifier variable on line #5.

Caution:

The site ID must remain enclosed within single quotes, the way it appears by default.

2. From the Teamcenter command prompt, where TC_ROOT, TC_DATA and TC_DATA/tc_profilevars are
set, run the following command:

tcxml_import -u=<user> -p=<password> -g=<group> -file=<Path to the View XML file>
-xsl=<Path to the View XSLT file>

Example:

TC_DATA/RetailSamples/OperatingSystem/samples/lineplanviews
/Default_View.xsl>-optionset=
RetailLinePlanViewImportOptionSetDefault

Customizing retail line assortment plan views

You can customize the default XSLT file, named Default_View.xsl, located at TC_DATA/RetailSamples/
OperatingSystem/samples/lineplanviews to add more attributes.

• A new TIE import set can be used to import the retail line assortment plan views.

In case a new option set is used to import the retail line assortment plan views, ensure that it contains
an option with the name retailLinePlanViewImportMode and that the value of the option is set to
True.

• For a private view or a user-specific view, import the user profile with the particular view, and in the
Default_View.xsl file, make sure that fnd0IsSharable is set to N.

3. Setting up line plan views and importing HTS codes
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Import HTS codes

Harmonized Tariff System (HTS) codes, which are specific to the U.S, are used to look up duty
percentages based on the country of manufacturing and the destination of imported items. Companies
download these HTS code tables in the .xls format and use these as reference to calculate the duty
percentage costs.

Administrators can use the htsbulkimport.bat utility to import these HTS code tables, so that the duty
percentages are available during assortment planning for the line.

1. Create a folder retail at the location where you have installed Teamcenter.

For example, if Teamcenter is installed at C:\apps\tc\tc112\TR create the retail folder at
C:\apps\tc\tc112\TR\data\csv2tcxml\examples.

2. Browse to the C:\apps\tc\tc112\TR\data\csv2tcxml folder.

3. Open the csv2tcxml.ini file to update the value of the source_site parameter with a valid site ID.

If you do not have this ID, contact Customer Support.

4. Browse to C:\apps\tc\tc112\TR\data\csv2tcxml\model\datamodel folder.

5. Modify the local_override.xml file to include the following:

<CSV2TCXML>
<TcClass className="Ret0ScheduleCodeAndTariff" keyAttributes=
"ret0TariffCode">
</TcClass>
<TcClass className="Ret0Tariff"
 keyAttributes="ret0CountryOfOrigin,ret0DestinationCountry,
ret0OwningObject,ret0StartDate,ret0EndDate">
  </TcClass>
</CSV2TCXML>

6. Browse to C:\apps\tc\tc112\TR\data\csv2tcxml and run the following command:

tcperl csv2tcxml.perl install

7. Copy the footwearHTS.xlsx and HTS_bulk_import_config.properties files to the
C:\apps\tc\tc112\TR\data\csv2tcxml\examples\retail folder.

8. Browse to C:\apps\tc\tc112\TR\data\csv2tcxml\examples\retail and run the following command to
generate the intermediate csv file:

Import HTS codes
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htsbulkimport.bat footwearHTS.xlsx footwearHTS retail\
HTS_bulk_import_config.properties

9. Run the following command to create the tcxml file:

tcperl csv2tcxml.perl C:\apps\tc\tc112\TR\data\csv2tcxml\
examples\retail\Ret0ScheduleCodeAndTariff.csv

10. Run the following command to import the tcxml file:

tcxml_import -file=Ret0ScheduleCodeAndTariff.csv.xml 
-u=Tc-admin-user -p=password -low_level -bulk_load

3. Setting up line plan views and importing HTS codes
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4. Managing schedules
The need for schedule management in the retail industry

In the retail industry multiple designers, merchandisers and sourcing manager work on different aspects
of the production process simultaneously. Designers work on trend development and storyboards,
materials managers work on fabric and trim development and color lab dip tracking. Technical designers
work on specification development and fit sample tracking, while sourcing managers manage suppliers,
conduct reverse auctions, and help ensure product quality.

Therefore, there are many tasks, milestones, and approvals that take place among a global product
development team, across multiple processes. All of these need to roll up into a single calendar
view. These tasks, milestones, and approvals need to be embedded throughout the development and
sourcing process. Additionally, they must be made available for viewing and action-taking on any device,
anywhere, whether on a laptop in the office, or a smart phone in the airport.

The Retail Footwear and Apparel solution provides product schedule templates containing tasks
and workflows to manage these processes. As an administrator, you set up these according to your
organization's needs.

About the Footwear Product Schedule Template

The Footwear Product Schedule Template is provided as part of the Retail Footwear and Apparel
installation. Once this template is imported into the target Teamcenter server, you must classify it as
Product→Footwear. You must also assign a user to each schedule task based upon your organization's
need.

The template contains the following schedule tasks and the associated workflow templates.

Schedule tasks Use the Schedule task to Associated workflow template

Initial Sample
Request Sent

Create the prototype sample
requests, send it to the
respective vendor, and
receive samples against
each sample request.

Initial Sample Request Sent WF

Line Review Review each prototype
sample against its
corresponding sample
request.

Line Review WF

Fit/Spec Sample
Request Sent

Create the Fit/Spec sample
requests, send it to the
respective vendors, and

Fit/Spec Sample Request Sent WF
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Schedule tasks Use the Schedule task to Associated workflow template

receive samples against
each sample request.

Rcv Fit/Spec
Sample

Validate whether you have
received all the Fit/Spec
samples as requested from
the vendors.

Rcv Fit/Spec Sample WF

Approve Fit/Spec Review each Fit/Spec sample
against its corresponding
sample request.

Approve Fit/Spec WF

Approve Design
BOM

Review Footwear Product
Structure (design BOM) and
approve or reject the design
as appropriate.

Approve Design BOM WF

Approve M BOM Review Footwear Product
Structure (manufacturing
BOM) and approve or reject
as appropriate.

Approve M BOM WF

Final Cost Approve the final cost for
the footwear product based
on its configuration.

Final Cost WF

Release for
Production

Mark your approval (or
rejection) on whether
to release the footwear
product for production or
not.

Release for Production WF

Approve Pre
Production

Bypass the preproduction
sample requests, tracking,
and approval.

Approve Pre Production WF

Approve TOP Bypass Top of Production
(TOP) sample requests,
tracking, and approval.

Approve TOP WF

In the Footwear Product Schedule Template, user assignment for each schedule task is configurable
and can be changed by using Schedule Manager application. Similarly, duration for each schedule task
can be configured as needed using Schedule Manager application.

Each schedule task is associated with a workflow template through a workflow trigger to execute it
automatically.

The workflow associated to first schedule task is through workflow trigger named as Scheduled start
date and the rest of the workflow is associated to its schedule task through workflow trigger named

4. Managing schedules
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as Predecessors complete. This workflow trigger is configurable for each schedule task and associated
workflow task.

Note:

You must install and configure the Workflow to Scheduling Integration option in Deployment
Center or Teamcenter Environment Manager (TEM) to initiate workflows on schedule tasks where
the workflow trigger type is Scheduled start date, Both Scheduled start date and predecessors
complete, or Either Scheduled start date and predecessors complete.

For more information, in the Teamcenter help, see Installing Teamcenter>Teamcenter
Environment Manager Help>Teamcenter integrations>Workflow to Scheduling Integration
settings.

Setting up schedules

Creating and managing schedule tasks

About schedule tasks

Schedule tasks, which appear on the schedule's Tasks tab, identify the activities and deliverables for
a schedule. You can open a task to view the properties, deliverables, assigned members, and task
dependencies.

Schedule tasks behave the same whether they are created on a schedule, master schedule, or
subschedule.

The following applies to schedule tasks:

• The top line on the Tasks tab is the schedule summary task for the schedule and cannot be modified
or deleted.

About schedule tasks
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• When you insert a subschedule into a schedule, the subschedule appears as a schedule task on the
master schedule.

• Opening a subschedule from the Tasks tab opens the subschedule as a Schedule Task of the
master schedule. You can assign deliverables and create task dependencies just as you would on a
standard schedule task.

• To navigate to the subschedule from within the subschedule task, click the Schedule link on the
subschedule task's Overview tab.

• When you add schedule tasks to a subschedule, the tasks roll up to the master schedule and appear
on the master schedule's Tasks tab. They also appear on the subschedule's Tasks tab.

• To add a task to a subschedule task while in the master schedule, select the subschedule task from
the task list and add the task.

• To create a milestone task on a schedule or subschedule, use Add Milestone   on the Gantt tab, or
create a task with no duration value on the Tasks tab.

Add or delete a schedule task

As a schedule coordinator, you can add a task to, or delete a task from, a schedule or subschedule as
the schedule scope changes. A task can be deleted even if it is associated with a running workflow.
If the deleted task is associated with a running workflow, the workflow is stopped and downstream
workflow tasks are prevented from starting. You can add or remove a task using the Task tab or the
Gantt tab—whichever view you prefer.

Navigate to the schedule

1. Search for the schedule using the search box, click SCHEDULES on your home page, or navigate to
the schedule in your folder structure.

2. (Optional) Filter the returned list to quickly find the desired schedule.

3. Click Open .

4. Click the Tasks tab.

5. Add a task to a schedule or delete a task from a schedule.

Add a task to a schedule or subschedule

1. Navigate to the schedule.

2. Do one of the following.

4. Managing schedules
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To Do

Add a task to a
schedule or master
schedule.

Select the task beneath which you would like to add the new task.

If you don't make a selection from the list, the task is added to the
bottom of the list.

Add a task to a
subschedule.

Select the subschedule task from the list.

Note:

A task can be added to a subschedule either from the
subschedule's Tasks tab, or as described here by selecting the
subschedule task from the master schedule's Tasks tab.

3. Click Add Schedule Task .

4. In the Add Schedule Task panel on the New tab, select Schedule Task, or click the Palette tab to
paste a task from the clipboard.

5. Complete the schedule task information.

6. Click Add.

Delete a task from a schedule

1. Navigate to the schedule.

Add or delete a schedule task
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2. Select the task that you want to delete.

3. Click Edit   > Delete.

4. Click Delete on the message that is displayed.

Change a schedule task's duration

As a schedule coordinator, you can quickly update a schedule task's duration in the Gantt view by
dragging the task's left handle (start date) and/or right handle (finish date) to a new spot on the date
line.

Note:

You can also update a schedule task's start and finish dates by editing the schedule task's
properties on schedule task's Overview tab.

1. Open a schedule.

2. From the Gantt chart view, hover over the task that you want to modify.

The task information appears, the task's connection points are displayed on either side of the task,
and one side of the task is enabled for dragging.

Note:

This action is constrained by the Use Finish Date Scheduling flag. If this schedule uses finish
date scheduling, the task's left handle is enabled for dragging. If this schedule does not use
finish date scheduling, the task's right handle is enabled for dragging.

3. Drag the left task handle to the left to change the start date, or drag the right task handle to the
right to change the finish date, and release.

4. Managing schedules
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The cursor changes to a bidirectional arrow during the move process.

Reschedule a schedule task

As a schedule coordinator, you can quickly reschedule a task in the Gantt chart by dragging the task to a
new start time. This action does not change the duration of the task. The task's start and finish dates are
automatically updated, as are any existing task dependencies.

Note:

You can also reschedule a task by editing the schedule task's planning properties on the Overview
tab or on the Information panel in the Gantt view.

1. Open a schedule.

2. From the Gantt chart view, hover over the task that you want to modify.

The task information appears and the task's connection points are displayed on either side of the
task.

3. Click and drag the entire task to the desired location.

Classify a schedule template

Perform the following steps to classify a schedule template:

1. In Active Workspace Client, search for the Footwear Product Schedule Template schedule
template.

2. Open the Footwear Product Schedule Template and click Classify .

3. In the Classify panel, in Class, select the class as Product→Footwear.

4. Click Set Class.

5. Click Classify.

Specifying the time zone for a schedule template

To specify the time zone for a schedule template, in Teamcenter Rich Client, you must set the Site
TimeZone preference to the required value.

Reschedule a schedule task
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Assign or unassign a schedule task resource

As the schedule coordinator, you can assign and maintain the resources responsible for working on each
schedule task by assigning the task to a user, a resource pool, or a discipline. Use resource pools if you
want to allow open-ended task assignments, which permit any user to accept responsibility for a task
that is assigned to a group, role, or a role in a group. Use disciplines, such as change analyst or engineer,
if you do not know the actual user that you want to assign to the task. Disciplines act as a placeholder
for the task assignment until you know which specific user to assign to the task.

From the schedule's Task tab you can add a single user, resource pool, or discipline to one or more
schedule tasks. From the schedule task's Members tab you can add a single user to a single schedule
task.

You can unassign a user, resource pool, or discipline from a schedule task from either the schedule's
Task tab or from the schedule task's Members tab.

Note:

Assigning a user to a schedule task also adds the user to the schedule membership as a participant
(team member).

Navigate to the schedule task within the schedule

1. Search for the schedule using the search box, click SCHEDULES on your home page, or navigate to
the schedule in your folder structure.

2. (Optional) Filter the returned list to quickly find the desired schedule.

3. Select a schedule from the list and click Open .

4. Click the Tasks tab.

5. Assign a user, resource pool, or discipline, or unassign a user, resource pool, or discipline from the
schedule task.

Assign a user, resource pool, or discipline to one or more schedule tasks

1. Do one of the following.

To Do

Assign a user,
resource pool, or
discipline to one
or more schedule
tasks using the

a. Select a task, or enter multiselect mode to select multiple tasks from the
list, and click Manage   > Assign/Unassign Resources.

b. Select the appropriate tab in the Assign Resource panel (Users,
Resource Pool, or Discipline).

4. Managing schedules
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To Do

schedule's Task
tab.

Assign a user to a
schedule task
using the task's
Member tab.

a. Select a schedule task from the list and click Open .

b. Click the Members tab.

c. Click Assign Resource .

2. (Optional) If the schedule task has been assigned to a Teamcenter project, you can narrow the
resource list to a specific project by selecting a project from the Project box. If no value is selected,
the organization user list appears.

3. Select the desired resource by doing the following.

a. Select a user, resource pool, or discipline from the list or search for a user, resource pool, or
discipline by entering a value in the Filter box.

b. (Optional) Click Resource Load  on the resource's tile to view the resource's work load
before committing to the assignment.

You must be assigned to the Resource Graph Viewers role to view the resource's work load.

c. Select a user.

Assign or unassign a schedule task resource
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4. Click Assign.

Unassign a user, resource pool, or discipline from one or more schedule tasks

To Do

Remove a user,
resource pool,
or discipline
from one or
more schedule
tasks using the
schedule's Task
tab.

1. Select one or more tasks from the list and click Manage   > Unassign
Resources.

Tip:

To select more than one task, enter multiselect mode.

2. Select the appropriate tab in the Assign Resource panel (Users, Resource
Pool, or Discipline).

3. Under the Assigned section, click Unassign  next to the resource you
want to remove from the task.

4. Click Save.

4. Managing schedules

4-10  Retail Footwear and Apparel ─ Administration, Teamcenter 2412
© 2025 Siemens



To Do

Remove a user,
resource pool, or
discipline from
one schedule task
using the task's
Member tab.

1. Select a schedule task from the list and click Open .

2. Click the Members tab.

3. Select the user, resource pool, or discipline that you want to remove.

4. From the primary toolbar, click Manage  > Unassign Resource.

Assign or unassign a schedule task resource
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5. Setting up templates for material test
requests
Create the testing results template for retail material test requests

You can create testing result templates to be attached with material test requests or import the OOTB
sample templates provided in the …\RetailSamples\windows\samples folder.

To create a testing result template:

1. Navigate to the Home folder and click Add to .

2. In the Add panel, search for Testing Results Template.

3. Click Choose File and browse to select the file (.doc format) that you want to use as a template.

4. Specify the Name and Description.

5. From the Reference list, select Ret0Word.

6. Click Add to create the testing result template.

7. Open the template and choose More commands  > Manage > Classify.

8. In the Classify panel, select Document > Material, and then select the appropriate testing type as
required. For example, if you are creating a testing result template for compression tests, choose
Document > Material, and from the Material Testing Type list, select Compression.

9. Click Classify.

When users create the material test request and specify the testing type, the classified template now
appears in the list.

Import the document testing templates for test material requests

Administrators can import the document testing templates to be attached with the material test
requests. When trim librarians create retail materials, classify them, and create material test requests,
the respective document template that includes the material attributes is attached to the material
sample test requests.

1. Import the testing template:

a. Log on as an administrator and open the tc command prompt window.
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b. Use the admin_data_import to import the files.

For example, to import the sample RetailMatTestingAttributeExLO.zip file provided by
default in the …\RetailSamples\windows\samples\AttributeExchange folder, run the following
command:

admin_data_import -u=Tc-admin-user -p=password -g=group 
-adminDataTypes=all

-inputPackage=C:\apps\tc\tc112\TD\RetailSamples\windows\samples\

AttributeExchange\RetailMatTestingAttributeExLO.zip

c. To confirm that the import was successful, log on to Active Workspace using your system
administrator credentials. Here, you can view the logical objects related to Retail.

2. Verify the workflow setup:

5. Setting up templates for material test requests
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a. Search for the AttributeExchangeTemplateForRetail workflow and make sure that the Set
Stage to Available check box is selected.

b. For the UpdateLogicalAttributesTask workflow handler, ensure that DOCMGT-update-
docprop-logicalobject is registered as the action handler for the Complete action.

3. In the rich client, choose Tools > Import > plmxml, and import the .xml file, which is the document
test template.

For example, import the sample file CompressionTestingTemplateOfRubber.xml provided in
RetailMatTestingAttributeExLO.zip.

4. Log on to Retail Footwear and Apparel and search for the document template that you want to
attach to the material test request.

For example, search for the CompressionTestingTemplateOfRubber.doc file.

5. Open the document template and choose Manage > Classify to classify it according to the testing
type.

For example, to classify a document template for compression tests, choose Document > Material
and from the Material Testing Type list, select Compression.

Import the document testing templates for test material requests
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6. In the rich client, select the Compressiontesting dataset and choose Edit properties.

7. In the Edit Properties dialog box, set the Logical Object Type Relation property to
RetailMattestingAttrExch.

5. Setting up templates for material test requests
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8. In Retail Footwear and Apparel, open the retail material and choose Manage > Classify.

9. In the Classify panel, classify the material. If the material is already classified, make sure that the
document template is classified for the respective material.

For example, select Raw Material > Material > Rubber.

10. Create a material test request for the newly created material and submit it to the
AttributeExchangeTemplateForRetail workflow. The attributes of the material are automatically
included in the document template.

For example, in the material test request, the Testing Type is specified as
Compression Test, and you initiate the AttributeExchangeTemplateForRetail workflow, the
CompressionTestingTemplateOfRubber.docx file, which has the material name, material ID, material
supplier name, and other attributes with the actual values, is attached to the test request.

Partners can download and view the attached CompressionTestingTemplateOfRubber.docx file to
prepare and submit their response.

Import the document testing templates for test material requests
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Note:

You can also add additional testing parameters or fields to the document template. To do this,
you must modify the logical objects to add the required properties and reimport the template to
Teamcenter.

5. Setting up templates for material test requests
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6. Managing workflow templates
Working with workflow templates

In a footwear product schedule template, each schedule task is associated to a workflow template
through workflow trigger to execute it automatically.

Following are the workflow templates used in the footwear product schedule template.

• Initial sample request sent WF

• Initial sample request track WF

• Line Review WF

• Initial sample request Approval WF

• Fit/Spec Sample Request Sent WF

• Sample Request Track WF

• Rcv Fit/Spec Sample WF

• Approve Fit/Spec WF

• Sample Request Approval WF

• Approve Design BOM WF

• Approve M BOM WF

• Final Cost WF

• Release for Production WF

• Approve Pre Production WF

• Approve TOP WF

Note:

The workflows in Retail Footwear and Apparel are designed for the following groups and roles:
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Group Role

Engineering Designer

Engineering Technical Designer

Product Development Manager

Workflow templates in Retail Footwear and Apparel

Initial Sample Request Sent Workflow

Purpose

This workflow is for initial sample request creation and its tracking purpose. This workflow process is to
be initiated by the Initial Sample Request Sent Schedule task of footwear product schedule template.

Workflow Tasks Step Description Template Actor Comments
Submit Initial
Sample Request

Submit Initial Sample
Request

Workflow/

Designer/*

Designer creates Proto Sample
Requests for the product.

Create Track WF for
each sample

Create Track WF for
each sample

Automatic Task
(No Actor)

System creates sub process for each
proto sample request created in
above step for tracking its status
purpose.

Note:

Task assignment in above workflow template is configurable provided workflow named ACL
(‘Footwear WF ACL’) and teamcenter organization changed appropriately.

Handlers

Handler Step Purpose

RETAIL-change--
job-name

Assign Changes workflow process name to make it unique.

RETAIL-attach-
sch-deliverable--
target-object

Assign Attaches schedule deliverable object as target object for
the process.

EPM-auto-assign Submit Initial Sample
Request →Start

Assigns current task to the resource pool(Workflow/
Designer/*)

6. Managing workflow templates
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Handler Step Purpose

EPM-set-duration Submit Initial Sample
Request→ Start

Sets the duration for the current task.

EPM-set-rule-
based-protection

Submit Initial Sample
Request→ Start

Sets the rule based protection as defined in workflow
named ACL for the current task.

RETAIL-check--
sample-request--
count

Submit Initial Sample
Request→ Complete

Checks if at least one proto sample request got created for
the target object (Footwear Product)

RETAIL-
assert-checked-in

Submit Initial Sample
Request→ Complete

Checks if target object and all the proto sample requests
of footwear product are checked in.

RETAIL-
attach-related-
sample-request-
target-object

Create Track WF for
each sample→ Start

Attaches all proto sample requests of footwear product as
target object.

EPM-create-sub-
process

Create Track WF for
each sample→ Start

Creates sub process for each proto sample request.

EPM-
remove-objects

Create Track WF for
each sample→ Start

Removes all proto sample requests of footwear product as
target object.

RETAIL-
check-sample-
request

Create Track WF
for each sample→
Complete

Checks if at least one proto sample received from vendor.

Depending on how the workflow needs to be configured, the sequence and arguments of the workflow
can be changed to support different behavior.

Initial Sample Request Track Workflow

Purpose

The purpose of this workflow is to track proto sample request sent to vendor and sample received from
vendor. This is a sub process of the Initial Sample Request Sent Workflow which supposed to be triggered
by the EPM-create-sub-process handler. Also, this workflow is manually instantiated on the late add
proto sample request.

Workflow Tasks Step Description Template Actor Comments
Sent Sample
Request To Vendor

Sent Sample Request
To Vendor

Workflow/

Designer/*

Designer sends Proto Sample Request for
the Product to the relevant vendor offline
and signoff the task.

Received Sample
From Vendor

Received Sample
From Vendor

Workflow/ Product Manager receives Proto Sample
Request for the Product to the relevant
vendor offline and signoff the task.

Initial Sample Request Track Workflow
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Workflow Tasks Step Description Template Actor Comments
Product
Manager/*

Note:

Task assignment in above workflow template is configurable provided workflow named ACL
(‘Footwear WF ACL’) and teamcenter organization is changed appropriately.

Handlers

Handler Step Purpose

RETAIL-
change-job-name

Assign Changes workflow process name to make it unique.

EPM-auto-assign Sent Sample Request
To Vendor→Start

Assigns current task to the resource pool (Workflow/
Designer/*)

RETAIL-
assert-checked-in

Sent Sample Request
To Vendor→Complete

Checks if target object is checked in.

EPM-auto-assign Received Sample
From Vendor→Start

Assigns current task to the resource pool (Workflow/
Product Manager/*)

RETAIL-
assert-checked-in

Received
Sample From
Vendor→Complete

Checks if target object is checked in.

RETAIL-trigger--
action-on--
related-process

Received
Sample From
Vendor→Complete

Triggers parent/related object’s workflow process “Create
Track WF for each sample” task →Complete action.

Depending on how the workflow needs to be configured, the sequence and arguments of the workflow
can be changed to support different behavior.

Line review workflow

Purpose

This workflow is for reviewing proto sample(s) against proto sample request(s) sent to vendor. The
Line Review Workflow process is to be initiated by the Line Review Schedule task of footwear product
schedule.

6. Managing workflow templates
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Workflow Tasks Step Description Template Actor Comments
Verify Samples for
Product

Verify Samples for
Product

Workflow/

Product Manager/*

Designer sends Proto Sample Request
for the Product to the relevant vendor
offline and signoff the task.

Received Sample
From Vendor

Received Sample
From Vendor

Automatic Task

(No Actor)

System creates sub process for each
proto sample request for sample review
purpose.

Note:

Task assignment in above workflow template is configurable provided workflow named ACL
(‘Footwear WF ACL’) and Teamcenter organization is changed appropriately.

Handlers

Handler Step Purpose

RETAIL-
change-job-name

Assign Changes workflow process name to make it unique.

RETAIL-attach--
sch-deliverable--
target-object

Assign Attaches schedule deliverable object as target object for
the process

EPM-auto-assign Verify Samples for
Product→Start

Assigns current task to the resource pool(Workflow/
Product Manager/*)

EPM-set-duration Verify Samples for
Product→Start

Sets the duration for the current task.

EPM-set-rule-
based-protection

Verify Samples for
Product→Start

Sets the rule based protection as defined in workflow
named ACL for the current task.

RETAIL-
check-sample-
request

Verify Samples for
Product→Complete

Checks if all proto sample(s) received from vendor against
each proto sample request(s).

RETAIL-
assert-checked-in

Verify Samples for
Product→Complete

Checks if target object and all the proto sample requests
of footwear product are checked in.

RETAIL-
attach-related-
sample-request-
target-object

Approve Initial
Sample→Start

Attaches all proto sample requests of footwear product as
target object.

EPM-create-sub-
process

Approve Initial
Sample→Start

Creates sub process for each proto sample request review
purpose.

Line review workflow
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Handler Step Purpose

EPM-set-rule-
based-protection

Approve Initial
Sample→Start

Sets the rule based protection as defined in workflow
named ACL for the current task.

EPM-
remove-objects

Approve Initial
Sample→Complete

Removes all proto sample requests of footwear product as
target object.

Depending on how the workflow needs to be configured, the sequence and arguments of the workflow
can be changed to support different behavior.

Late Add Proto Sample Request

Proto sample request created after the Submit Initial Sample Request workflow task of Initial Sample
Request Sent workflow, and before completion of Verify Samples for Product workflow task of Line
Review workflow will be considered as Late Add Proto Sample Request.

For lately added proto sample request, user has to manually initiate the Initial Sample Request Track
workflow after creating the sample request.

Initial sample request approval workflow

Purpose

The purpose of this workflow is to review proto sample received from vendor. This is a sub process of
Line Review workflow, which supposed to be triggered by the EPM-create-sub-process handler.

Workflow
Tasks Step Description Template Actor Comments
Adopt/Drop Adopt/Drop Workflow/

Designer/*

Designer decides proto sample (received from
vendor) to Approve or Reject or Reject See
Again

Update Status Update Status Automatic Task

(No Actor)

In case of Approve, system updates proto
sample request as ‘Approved’ and update
schedule status.

Suspend
Schedule

Suspend
Schedule

Automatic Task

(No Actor)

In case of Reject, system updates proto sample
request as ‘Rejected’ and schedule suspended.

Sent Sample
Request To
Vendor

Sent Sample
Request To
Vendor

Workflow/

Designer/*

In case of Reject See Again, System updates
status on current revision of proto sample
request as ‘Reject See Again’ and creates a
new revision of proto sample request. Now,
Designer sends This new revision of Proto

6. Managing workflow templates
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Workflow
Tasks Step Description Template Actor Comments

Sample Request to the relevant vendor offline
and signoff the task.

Received
Sample From
Vendor

Received Sample
From Vendor

Workflow/

Product
Manager/*

Product Manager receives Proto Sample Request
to the relevant vendor offline and signoff the
task.

Note:

Task assignment in the above workflow template is configurable provided the workflow named
ACL (Footwear WF ACL) and Teamcenter organization is changed appropriately.

Handlers

Handler Step Purpose

RETAIL-
change-job-name

Assign Changes workflow process name to make it unique.

EPM-auto-assign Adopt/Drop →Start Assigns current task to the resource pool (Workflow/
Designer/*)

EPM-set-duration Verify Samples for
Product →Start

Sets the duration for the current task.

EPM-set-rule-
based-protection

Adopt/Drop→ Start Sets the rule based protection as defined in workflow
named ACL for the current task.

RETAIL-
assert-checked-in

Adopt/Drop
→Complete

Checks if target object is checked in.

EPM-
check-condition

Update Status→ Start Attaches all proto sample requests of footwear product as
target object.

EPM-set-rule-
based-protection

Update Status→ Start Sets the rule based protection as defined in workflow
named ACL for the current task.

RETAIL-
add-status-
on-footwear

Update Status→
Complete

Sets status on related footwear of the target proto sample
request as Line Review is Complete.

EPM-
check-condition

Suspend Schedule
→Start

Checks if the decision set as FALSE for previous condition
task by end user

EPM-set-rule-
based-protection

Suspend Schedule →
Start

Sets the rule based protection as defined in workflow
named ACL for the current task.

RETAIL-
trigger-action-

Suspend Schedule→
Complete

Triggers parent/related process specified (started) task as
Suspend.

Initial sample request approval workflow
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Handler Step Purpose

on-related-
process

EPM-set-rule-
based-protection

Sent Sample Request
to Vendor→Start

Sets the rule based protection as defined in workflow
named ACL for the current task.

EPM-
create-status

Sent Sample Request
to Vendor →Start

Creates a release status named as Reject See Again

EPM-set-status Sent Sample Request
to Vendor→ Start

Sets the Reject See Again status on the current revision
of the sample request.

RETAIL-reject-see-
again

Sent Sample Request
to Vendor→ Start

Creates new revision of proto sample request. Removes
old revision from target object and attaches new revision
as target object.

EPM-auto-assign Sent Sample Request
to Vendor→ Start

Assigns current task to the resource pool (Workflow/
Designer/*)

EPM-set-duration Sent Sample Request
to Vendor→ Start

Sets the duration for the current task.

EPM-auto-assign Received Sample
from Vendor→ Start

Assigns current task to the resource pool (Workflow/
Product Manager/*)

Depending on how the workflow needs to be configured, the sequence and arguments of the workflow
can be changed to support different behavior.

Fit/Spec Sample Request Sent workflow

Purpose

This workflow is for creating and tracking the Fit/Spec sample request. This workflow process is to be
initiated by the Fit/Spec Sample Request Sent schedule task of footwear product schedule.

Workflow Tasks Step Description Template Actor Comments
Submit Fit/Spec
Sample Request

Submit Fit/Spec
Sample Request

Workflow/Tech
Designer/*

Tech Designer creates Fit/Spec
Sample Request(s) for the Product.

Create Track WF for
each sample

Create Track WF for
each sample

Automatic Task
(No Actor)

System creates sub process for each
Fit/Spec sample request created in
above step for tracking its status
purpose.

6. Managing workflow templates
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Note:

Task assignment in above workflow template is configurable provided workflow named ACL
(Footwear WF ACL) and Teamcenter organization is changed appropriately.

Handlers

Handler Step Purpose

RETAIL-
change-job-name

Assign Changes workflow process name to make it unique.

RETAIL-attach--
sch-deliverable--
target-object

Assign Attaches schedule deliverable object as target object for
the process.

EPM-auto-assign Submit Fit/Spec
Sample Request→
Start

Assigns current task to the resource pool(Workflow/Tech
Designer/*)

EPM-set-duration Submit Fit/Spec
Sample Request→
Start

Sets the duration for the current task.

EPM-set-rule-
based-protection

Submit Fit/Spec
Sample Request→
Start

Sets the rule based protection as defined in workflow
named ACL for the current task.

RETAIL-
check-sample-
request

Submit Fit/Spec
Sample Request→
Complete

Checks if at least one proto sample request got approved.

RETAIL-
check-sample-
request-count

Submit Fit/Spec
Sample Request→
Complete

Checks if at least one Fit/Spec sample request got created
for the target object (Footwear Product)

RETAIL-
assert-checked-in

Submit Initial Sample
Request→ Complete

Checks if target object and all the Fit/Spec sample
requests of footwear product are checked in.

RETAIL-attach--
related-sample-
request-target-
object

Create Track WF for
each sample→ Start

Attaches all Fit/Spec sample requests of footwear product
as target object.

EPM-create-sub-
process

Create Track WF for
each sample→ Start

Creates sub process for each Fit/Spec sample request.

EPM-
remove-objects

Create Track WF for
each sample→ Start

Removes all Fit/Spec sample requests of footwear product
as target object.

Fit/Spec Sample Request Sent workflow
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Depending on how the workflow needs to be configured, the sequence and arguments of the workflow
can be changed to support different behavior.

Sample Request Track workflow

Purpose

The purpose of this workflow is to track Fit/Spec or Preproduction or TOP (Top of Production) sample
request sent to vendor and sample received from vendor. This is a sub process of the Fit/Spec Sample
Request Sent workflow which supposed to be triggered by the EPM-create-sub-process handler.
Also, this workflow is manually instantiated on the late add Fit/Spec or Preproduction or Top (Top of
Production) sample request.

Workflow Tasks Step Description Template Actor Comments
Sent Sample
Request To Vendor

Sent Sample
Request To Vendor

Workflow/Tech
Designer/*

Designer sends Fit/Spec Sample Request
for the Product to the relevant vendor
offline and signoff the task.

Received Sample
From Vendor

Received Sample
From Vendor

Workflow/Product
Manager/*

Product Manager receives Fit/Spec
Sample Request for the Product to the
relevant vendor offline and signoff the
task.

Note:

Task assignment in above workflow template is configurable provided workflow named ACL
(‘Footwear WF ACL’) and Teamcenter organization is changed appropriately.

Handlers

Handler Step Purpose

RETAIL-
change-job-name

Assign Changes workflow process name to make it unique.

EPM-auto-assign Sent Sample Request
To Vendor →Start

Assigns current task to the resource pool(Workflow/Tech
Designer/*)

RETAIL-
assert-checked-in

Sent Sample
Request To Vendor
→Complete

Checks if target object is checked in.

EPM-auto-assign Received Sample
From Vendor→ Start

Assigns current task to the resource pool(Workflow/
Product Manager/*)

RETAIL-
assert-checked-in

Received Sample
From Vendor
→Complete

Checks if target object is checked in.

6. Managing workflow templates
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Depending on how the workflow needs to be configured, the sequence and arguments of the workflow
can be changed to support different behavior.

Rcv Fit/Spec Sample workflow

Purpose

This workflow is for reviewing Fit/Spec sample(s) against Fit/Spec sample request(s) sent to vendor. The
Rcv Fit/Spec workflow is to be initiated by Rcv Fit/Spec Sample schedule task of footwear product
schedule.

Workflow Tasks Step Description Template Actor Comments
Rcv Fit/Spec Sample Rcv Fit/Spec Sample Workflow/Product

Manager/*
Product Manager verifies whether all
proto samples are received against
proto sample request(s) for the Product.

Note:

Task assignment in above workflow template is configurable provided workflow named ACL
(Footwear WF ACL) and Teamcenter organization is changed appropriately.

Handlers

Handler Step Purpose

RETAIL-
change-job-name

Assign Changes workflow process name to make it unique.

RETAIL-attach--
sch-deliverable--
target-object

Assign Attaches schedule deliverable object as target object for
the process.

EPM-auto-assign Rcv Fit/Spec Sample
→Start

Assigns current task to the resource pool(Workflow/
Product Manager/*)

EPM-set-duration Rcv Fit/Spec Sample
→Start

Sets the duration for the current task.

EPM-set-rule-
based-protection

Rcv Fit/Spec Sample
→Start

Sets the rule based protection as defined in workflow
named ACL for the current task.

RETAIL-
check-sample-
request

Rcv Fit/Spec Sample
→Complete

Checks if all Fit/Spec sample(s) received from vendor
against each Fit/Spec sample request(s).

RETAIL-
assert-checked-in

Rcv Fit/Spec Sample
→Complete

Checks if target object and all the Fit/Spec sample
requests of footwear product are checked in.

Rcv Fit/Spec Sample workflow
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Depending on how the workflow needs to be configured, the sequence and arguments of the workflow
can be changed to support different behavior.

Late Add Fit/Spec Sample Request

A Fit/Spec sample request created after completion of the Submit Fit/Spec Sample Request workflow
task of the Fit/Spec Sample Request Sent workflow, and before completion of Rcv Fit/Spec Sample
workflow task of the Rcv Fit/Spec Sample workflow, will be considered as late add Fit/Spec Sample
Request.

For lately added fit/spec sample request, user has to manually initiate the Sample Request Track
workflow after creating a sample request.

Approve Fit Spec workflow

Purpose

The purpose of this workflow is to review Fit/Spec sample(s) received from vendor.

Workflow Tasks Step Description Template Actor Comments
Approve Sample Approve Sample Automatic Task (No

Actor)
System creates sub process for each Fit/
Spec sample request for sample review
purpose.

Note:

Task assignment in above workflow template is configurable provided workflow named ACL
(Footwear WF ACL) and Teamcenter organization is changed appropriately.

Handlers

Handler Step Purpose

RETAIL-
change-job-name

Assign Changes workflow process name to make it unique.

RETAIL-attach--
sch-deliverable--
target-object

Assign Attaches schedule deliverable object as target object for
the process.

RETAIL-attach--
related-sample-
request-target-
object

Approve Initial
Sample →Start

Attaches all Fit/Spec sample requests of footwear product
as target object.

6. Managing workflow templates
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Handler Step Purpose

EPM-create-sub-
process

Approve Initial
Sample→ Start

Creates sub process for each Fit/Spec sample request
review purpose.

EPM-set-
rule-based-
protection

Approve Initial
Sample →Start

Sets the rule based protection as defined in workflow
named ACL for the current task.

EPM-
remove-objects

Approve Initial
Sample →Complete

Removes all Fit/Spec sample requests of footwear product
as target object.

Depending on how the workflow needs to be configured, the sequence and arguments of the workflow
can be changed to support different behavior.

Sample Request Approval workflow

Purpose

The purpose of this workflow is to review Fit/Spec or Pre-Production or TOP (Top of Production) sample
received from vendor. This is a sub process of the Approve Fit/Spec, Approve Pre Production, and
Approve TOP workflow which supposed to be triggered by the EPM-create-sub-process handler.

Workflow
Tasks Step Description Template Actor Comments
Sample
Approval

Sample Approval Workflow/Tech
Designer/*

Tech Designer decides sample (received from
vendor) to Approve or Reject or Reject See
Again.

Update Status Update Status Automatic Task
(No Actor)

In case of approve, system updates sample
request as Approved and update schedule
status.

Suspend
Schedule

Suspend
Schedule

Automatic Task
(No Actor)

In case of Reject, system updates proto sample
request as Rejected and schedule suspended.

Sent Sample
Request To
Vendor

Sent Sample
Request To
Vendor

Workflow/-
Designer/*

In case of Reject See Again, System updates
status on current revision of sample request as
Reject See Again and creates a new revision of
sample request. Now, Tech Designer sends This
new revision of Sample Request to the relevant
vendor offline and signoff the task.

Received
Sample From
Vendor

Received Sample
From Vendor

Workflow/Product
Manager/*

Product Manager receives Proto Sample Request
to the relevant vendor offline and signoff the
task.

Sample Request Approval workflow
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Note:

Task assignment in above workflow template is configurable provided workflow named ACL
(Footwear WF ACL) and Teamcenter organization is changed appropriately.

Handlers

Handler Step Purpose

RETAIL-
change-job-name

Assign Changes workflow process name to make it unique.

EPM-auto-assign Sample Approval
→Start

Assigns current task to the resource pool(Workflow/Tech
Designer/*)

EPM-set-duration Sample Approval
→Start

Sets the duration for the current task.

EPM-set-
rule-based-
protection

Sample Approval
→Start

Sets the rule based protection as defined in workflow
named ACL for the current task.

RETAIL-
assert-checked-in

Sample Approval →
Complete

Checks if target object is checked in.

EPM-
check-condition

Update Status→ Start Checks if the decision set as TRUE for previous condition
task by end user.

EPM-set-rule-
based-protection

Update Status→ Start Sets the rule based protection as defined in workflow
named ACL for the current task.

EPM-
check-condition

Suspend Schedule →
Start

Checks if the decision set as FALSE for previous condition
task by end user.

EPM-set-rule-
based-protection

Suspend Schedule →
Start

Sets the rule based protection as defined in workflow
named ACL for the current task.

RETAIL-
trigger-action-
on-related-
process

Suspend Schedule→
Suspend

Triggers parent/related process specified (started) task as
Suspend.

EPM-set-
rule-based-
protection

Sent Sample Request
to Vendor→ Start

Sets the rule based protection as defined in workflow
named ACL for the current task.

EPM-create-
status

Sent Sample Request
to Vendor→ Start

Creates a release status named as Reject See Again.

EPM-set-status Sent Sample Request
to Vendor→ Start

Sets the Reject See Again status on the current revision
of the sample request.
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Handler Step Purpose

RETAIL-reject-
see-again

Sent Sample Request
to Vendor→ Start

Creates new revision of sample request. Removes old
revision from target object and attaches new revision as
target object.

EPM-auto-assign Sent Sample Request
to Vendor→ Start

Assigns current task to the resource pool(Workflow/
Designer/*)

EPM-set-duration Sent Sample Request
to Vendor→ Start

Sets the duration for the current task.

EPM-auto-assign Received Sample
from Vendor→ Start

Assigns current task to the resource pool(Workflow/
Product Manager/*)

Depending on how the workflow needs to be configured, the sequence and arguments of the workflow
can be changed to support different behavior.

Approval Design BOM workflow

Purpose

The purpose of this workflow is to review Footwear Product Structure (Design BOM) and select decision
as approve or reject accordingly.

Workflow Tasks Step Description Template Actor Comments
OR OR Automatic Task (No Actor) Logical ‘OR’
Design BOM
Approval

Design BOM Approval Workflow/Product
Manager/*

Product Manager approves
Design BOM of the footwear
product.

Note:

Task assignment in above workflow template is configurable provided workflow named ACL
(Footwear WF ACL) and Teamcenter organization is changed appropriately.

Handlers

Handler Step Purpose

RETAIL-
change-job-name

Assign Changes workflow process name to make it unique.

RETAIL-attach--
sch-deliverable--
target-object

Assign Attaches schedule deliverable object as target object for
the process.

Approval Design BOM workflow
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Handler Step Purpose

EPM-set-rule-
based-protection

Design BOM
Approval→Start

Sets the rule based protection as defined in workflow
named ACL for the current task.

EPM-set-
rule-based-
protection

Sample
Approval→Start

Sets the rule based protection as defined in workflow
named ACL for the current task.

EPM-set-duration Design BOM
Approval→Start

Sets the duration for the current task.

EPM-
adhoc-signoff

Design BOM
Approval→ select-
signoff-team →Start

Assigns perform-signoff task to the resource
pool(Workflow/Product Manager/*)

RETAIL-schmgt--
remove-
assigned--
reviewers

Design BOM Approval
→ select-signoff-team
→ Start

Removes the reviewer from the reviewer list of the
given review task. This reviewer is a privileged user who
is coming from schedule and acting as a reviewer in
workflow review task.

RETAIL-
assert-checked-in

Design BOM
Approval → performs-
signoff-team →
Complete

Checks if target object is checked in.

EPM-create-
status

Design BOM
Approval → performs-
signoff-team →
Complete

Creates a release status named as “Approve Design BOM is
Complete”

EPM-set-status Design BOM Approval
→ performs-signoff-
team → Complete

Sets the ‘Approve Design BOM is Complete’ on the current
revision of the sample request.

Depending on how the workflow needs to be configured, the sequence and arguments of the workflow
can be changed to support different behavior.

Approve M BOM workflow

Purpose

The purpose of this workflow is to review the Footwear Product Structure (M BOM) and set the decision
as Approve or Reject.

Workflow Tasks Step Description Template Actor Comments
OR 1 OR 1 Automatic Task (No Actor) Logical ‘OR 1’
Approve Tooling Approve Tooling Workflow/Product Manager/* Product Manager approves Tooling.
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Workflow Tasks Step Description Template Actor Comments
OR 2 OR 2 Automatic Task (No Actor) Logical ‘OR 2’
M BOM Approval M BOM Approval Workflow/Product Manager/* Product Manager approves M BOM

of the footwear product.

Note:

Task assignment in above workflow template is configurable provided workflow named ACL
(Footwear WF ACL) and Teamcenter organization is changed appropriately.

Handlers

Handler Step Purpose

RETAIL-
change-job-name

Assign Changes workflow process name to make it unique.

RETAIL-attach--
sch-deliverable--
target-object

Assign Attaches schedule deliverable object as target object for
the process.

EPM-set-
rule-based-
protection

Approve Tooling
->Start

Sets the duration for the current task.

EPM-set-duration Approve Tooling

→select-signoff-team

→Start

Assigns perform-signoff task to the resource pool
(Workflow/Product Manager/*)

EPM-
adhoc-signoff

Approve Tooling

→select-signoff-team

→Start

Assigns perform-signoff task to the resource pool
(Workflow/Product Manager/*)

RETAIL-schmgt-
remove--
assigned--
reviewers

Approve Tooling

→select-signoff-team

→Start

Removes the reviewer from the reviewer list of the
given review task. This reviewer is a privileged user who
is coming from schedule and acting as a reviewer in
workflow review task.

EPM-set-
rule-based-
protection

M BOM Approval
→Start

Sets the rule based protection as defined in workflow
named ACL for the current task.

EPM-set-duration M BOM Approval
→Start

Sets the duration for the current task.

EPM-
adhoc-signoff

M BOM Approval

→select-signoff-team

Assigns perform-signoff task to the resource
pool(Workflow/Product Manager/*)

Approve M BOM workflow
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Handler Step Purpose

→Start

RETAIL-schmgt--
remove--
assigned--
reviewers

M BOM Approval
→select-signoff-team
→Start

Removes the reviewer from the reviewer list of the
given review task. This reviewer is a privileged user who
is coming from schedule and acting as a reviewer in
workflow review task.

RETAIL-
assert-checked-in

M BOM
Approval →performs-
signoff-team
→Complete

Checks if target object is checked in.

EPM-create-
status

M BOM
Approval →performs-
signoff-team
→Complete

Creates a release status named as Approve M BOM is
Complete

EPM-set-status M BOM
Approval →performs-
signoff-team
→Complete

Sets the Approve M BOM is Complete status on the
current revision of the sample request.

Depending on how the workflow needs to be configured, the sequence and arguments of the workflow
can be changed to support different behavior.

Final Cost workflow

Purpose

The purpose of this workflow is to approve the final cost for the footwear product based on its
configuration.

Workflow Tasks Step Description Template Actor Comments
OR OR Automatic Task (No

Actor)
Logical ‘OR’

Approve Final Cost Approve Final Cost Workflow/Product
Manager/*

Product Manager approves final cost

Suspend Schedule Suspend Schedule Automatic Task (No
Actor)

In case of Reject, system updates
proto sample request as Rejected
and schedule suspended.

6. Managing workflow templates
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Note:

Task assignment in above workflow template is configurable provided workflow named ACL
(Footwear WF ACL) and Teamcenter organization is changed appropriately.

Handlers

Handler Step Purpose

RETAIL-change-
job-name

Assign Changes workflow process name to make it unique.

RETAIL-attach--
sch-deliverable--
target-object

Assign Attaches schedule deliverable object as target object for
the process.

EPM-set-
rule-based-
protection

Approve Final Cost
→Start

Sets the rule based protection as defined in workflow
named ACL for the current task.

EPM-set-duration Approve Final Cost
→Start

Sets the duration for the current task.

EPM-
adhoc-signoff

Approve Final Cost
→select-signoff-team
→ Start

Assigns perform-signoff task to the resource
pool(Workflow/Product Manager/*)

RETAIL-schmgt--
remove-
assigned--
reviewers

Approve Final Cost
→ select-signoff-team
→Start

Removes the reviewer from the reviewer list of the
given review task. This reviewer is a privileged user who
is coming from schedule and acting as a reviewer in
workflow review task.

RETAIL-
assert-checked-in

Approve Final
Cost → performs-
signoff-team →
Complete

Checks if target object is checked in.

EPM-create-
status

Approve Final
Cost →performs-
signoff-team→
Complete

Creates a release status named as “Final Cost is Complete”

EPM-set-status Suspend Schedule →
Start

Sets the ‘Final Cost is Complete’ on the current revision of
the sample request.

Depending on how the workflow needs to be configured, the sequence and arguments of the workflow
can be changed to support different behavior.

Final Cost workflow
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Release for production workflow

Purpose

The purpose of this workflow is to release the footwear product for production.

Workflow Tasks Step Description Template Actor Comments
OR Automatic Task (No Actor) Logical ‘OR’

Release for
Production

Release for Production Workflow/Product
Manager/*

Product Manager approves
Product to release for
production.

Note:

Task assignment in above workflow template is configurable provided workflow named ACL
(Footwear WF ACL) and Teamcenter organization is changed appropriately.

Handlers

Handler Step Purpose

CPR-change-job-
name

Assign Changes workflow process name to make it unique.

CPR-attach-sch-
deliverable--
target-object

Assign Attaches schedule deliverable object as target object for
the process.

EPM-set-
rule-based-
protection

Release for
Production →Start

Sets the rule based protection as defined in workflow
named ACL for the current task.

EPM-set-duration Release for
Production →Start

Sets the duration for the current task.

EPM-
adhoc-signoff

Release for
Production→select-
signoff-team→Start

Assigns perform-signoff task to the resource pool
(Workflow/Product Manager/*)

CPR-schmgt--
remove--
assigned--
reviewers

Release for
Production→select-
signoff-team→Start

Removes the reviewer from the reviewer list of the
given review task. This reviewer is a privileged user who
is coming from schedule and acting as a reviewer in
workflow review task.

CPR-
assert-checked-in

Release for
Production-
→performs-signoff--
team→Complete

Checks if target object is checked in.
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Handler Step Purpose

EPM-create-
status

Release for
Production-
→performs-signoff--
team→Complete

Creates a release status named as “Release for Production
Complete”

EPM-set-status Release for
Production-
→performs-signoff--
team→Complete

Sets the ‘Release for Production Complete’ on the current
revision of the sample request.

Depending on how the workflow needs to be configured, the sequence and arguments of the workflow
can be changed to support different behavior.

Approve Pre Production workflow

Purpose

The purpose of this workflow is to create pre-production sample request(s) and track these requests.
Also, review the sample(s) received against these sample request(s).

Workflow Tasks Step Description Template Actor Comments
Submit Pre
Production Sample

Submit Pre
Production Sample

Workflow/Tech
Designer/*

Tech Designer creates pre-production
Sample Request(s) for the Product.

Create track WF for
each Sample

Create track WF for
each Sample

Automatic Task
(No Actor)

System creates sub process for each
pre-production sample request created
in above step for tracking its status
purpose.

Verify Sample for
Product

Verify Sample for
Product

Workflow/Product
Manager/*

Product Manager verifies whether all pre-
production samples are received against
pre-production sample request(s) for the
Product.

Approve Sample Approve Sample Automatic Task
(No Actor)

System creates sub process for each pre-
production sample request for sample
review purpose.

Note:

Task assignment in above workflow template is configurable provided workflow named ACL
(‘Footwear WF ACL’) and Teamcenter organization is changed appropriately.

Approve Pre Production workflow
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Handlers

Handler Step Purpose

RETAIL-
change-job-name

Assign Changes workflow process name to make it unique.

RETAIL-attach--
sch-deliverable--
target-object

Assign Attaches schedule deliverable object as target object for
the process.

EPM-set-
rule-based-
protection

Submit Pre
Production
Sample→Start

Sets the rule based protection as defined in workflow
named ACL for the current task.

EPM-set-duration Submit Pre
Production
Sample→Start

Sets the duration for the current task.

RETAIL-check-
sample-request-
count

Submit Pre
Production
Sample→Complete

Checks if at least one pre-production sample request got
created for the target object (Footwear Product)

RETAIL-
assert-checked-in

Release for
Production
→performs-signoff-
team→Complete

Checks if target object is checked in.

RETAIL-attach--
related-sample-
request-target-
object

Create track WF for
each Sample →Start

Attaches all pre-production sample requests of footwear
product as target object.

EPM-create-sub-
process

Create track WF for
each Sample →Start

Creates sub process for each pre-production sample
request.

EPM-
remove-objects

Create track WF for
each Sample →Start

Removes all pre-production sample requests of footwear
product as target object.

EPM-set-
rule-based-
protection

Verify Samples for
Product→ Assign

Sets the rule based protection as defined in workflow
named ACL for the current task.

EPM-auto-assign Verify Samples for
Product→ Start

Assigns current task to the resource pool(Workflow/
Product Manager/*)

EPM-set-duration Verify Samples for
Product→ Start

Sets the duration for the current task.

RETAIL-
check-sample-
request

Verify Samples for
Product→ Complete

Checks if all pre-production sample received from vendor.
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Handler Step Purpose

RETAIL-
assert-checked-in

Verify Samples for
Product→ Complete

Checks if target object is checked in.

RETAIL-attach--
related-sample-
request-target-
object

Approve Sample→
Start

Attaches all pre-production sample requests of footwear
product as target object.

EPM-create-sub-
process

Approve Sample→
Start

Creates sub process for each pre-production sample.
Request review purpose.

EPM-set-
rule-based-
protection

Approve Sample→
Start

Sets the rule based protection as defined in workflow
named ACL for the current task.

EPM-
remove-objects

Approve Sample→
Complete

Removes all pre-production sample requests of footwear
product as target object.

EPM-create-
status

Approve Sample→
Complete

Creates a release status named as “Approve PreProduction
Complete”

EPM-set-status Approve Sample→
Complete

Sets the ‘Approve PreProduction Complete’ on the current
revision of the sample request.

EPM-
remove-objects

Approve Sample→
Suspend

Removes all pre-production sample requests of footwear
product as target object.

EPM-create-
status

Approve Sample→
Suspend

Creates a release status named as “Schedule Suspended”

EPM-set-status Approve Sample→
Suspend

Sets the ‘Schedule Suspended’ on the current revision of
the sample request.

Depending on how the workflow needs to be configured, the sequence and arguments of the workflow
can be changed to support different behavior.

Late Add Pre production Sample Request

A pre-production sample request created after completion of Submit Pre Production Sample workflow
task of the Approve Pre Production workflow, and before completion of the Verify Sample for Product
workflow task of the Approve Pre Production workflow, will be considered as Late Add Pre production
Sample Request.

For lately added Preproduction sample request, user has to manually initiate the Sample Request Track
workflow after creating the sample request.

Approve Pre Production workflow
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Approve TOP workflow

Purpose

The purpose of this workflow is to create and track the TOP (Top of Production) sample request(s), and
review the sample(s) received against these sample request(s).

Workflow Tasks Step Description Template Actor Comments
Submit TOP
Sample

Submit TOP Sample Workflow/Tech
Designer/*

Tech Designer creates TOP Sample
Request(s) for the Product.

Create track WF
for each Sample

Create track WF for
each Sample

Automatic Task (No
Actor)

System creates sub process for each TOP
sample request created in above step for
tracking its status purpose.

Verify Samples for
Product

Verify Sample for
Product

Workflow/Product
Manager/*

Product Manager verifies whether all
TOP samples are received against TOP
sample request(s) for the Product.

Approve Sample Approve Sample Automatic Task (No
Actor)

System creates sub process for each
TOP sample request for sample review
purpose.

Note:

Task assignment in above workflow template is configurable provided workflow named ACL
(Footwear WF ACL) and Teamcenter organization is changed appropriately.

Handlers

Handler Step Purpose

RETAIL-
change-job-name

Assign Changes workflow process name to make it unique.

RETAIL-attach--
sch-deliverable--
target-object

Assign Attaches schedule deliverable object as target object for
the process.

EPM-auto-assign Submit Pre
Production Sample→
Start

Assigns current task to the resource pool(Workflow/Tech
Designer/*)

EPM-set-
rule-based-
protection

Submit Pre
Production Sample
→Start

Sets the rule based protection as defined in workflow
named ACL for the current task.
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Handler Step Purpose

EPM-set-duration Submit Pre
Production
Sample→Start

Sets the duration for the current task.

RETAIL-check--
sample-request-
count

Submit Pre
Production
Sample→Complete

Checks if at least one TOP sample request got created for
the target object (Footwear Product)

RETAIL-
assert-checked-in

Release for
Production →

performs-

signoff-team→

Complete

Checks if target object is checked in.

RETAIL-attach--
related-sample-
request-target-
object

Create track WF for
each Sample →Start

Attaches all TOP sample requests of footwear product as
target object.

EPM-create-sub-
process

Create track WF for
each Sample→Start

Creates sub process for each TOP sample request.

EPM-remove-
objects

Create track WF for
each Sample→Start

Removes all TOP sample requests of footwear product as
target object.

EPM-set-
rule-based-
protection

Verify Samples for
Product→Assign

Sets the rule based protection as defined in workflow
named ACL for the current task.

EPM-auto-assign Verify Samples for
Product→ Start

Assigns current task to the resource pool(Workflow/
Product Manager/*)

EPM-set-duration Verify Samples for
Product →Start

Sets the duration for the current task.

RETAIL-
check-sample-
request

Verify Samples for
Product→ Complete

Checks if all TOP samples received from vendor.

RETAIL-
assert-checked-in

Verify Samples for
Product→ Complete

Checks if target object is checked in.

RETAIL-attach--
related-sample-
request-target-
object

Approve Sample→
Start

Attaches all TOP sample requests of footwear product as
target object.

EPM-create-sub-
process

Approve Sample→
Start

Creates sub process for each TOP sample request review
purpose.

Approve TOP workflow
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Handler Step Purpose

EPM-set-
rule-based-
protection

Approve Sample→
Start

Sets the rule based protection as defined in workflow
named ACL for the current task.

EPM-
remove-objects

Approve Sample→
Complete

Removes all TOP sample requests of footwear product as
target object.

EPM-create-
status

Approve Sample→
Complete

Creates a release status named as Footwear Schedule is
Complete.

EPM-set-status Approve Sample→
Complete

Sets the Footwear Schedule is Complete status on the
current revision of the sample request.

EPM-
remove-objects

Approve Sample→

Suspend

Removes all TOP sample requests of footwear product as
target object.

EPM-create-
status

Approve Sample→
Suspend

Creates a release status named as Schedule Suspended.

EPM-set-status Approve Sample→
Suspend

Sets the Schedule Suspended on the current revision of
the sample request.

Depending on how the workflow needs to be configured, the sequence and arguments of the workflow
can be changed to support different behavior.

Late Add TOP (Top of Production) Sample Request

A TOP sample request created after completion of the Submit TOP Sample workflow task of the
Approve TOP workflow, and before completion of the Verify Sample for Product workflow task of the
Approve TOP workflow, will be considered as late add TOP Sample Request.

For lately added TOP sample request, user has to manually initiate the Sample Request Track workflow
after creating the sample request.
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7. Managing vendors
Managing vendors in Retail Footwear and Apparel

You must set up vendors in Retail Footwear and Apparel such that they can search for and update retail
product samples.

You must configure the system in order to set up vendors in Retail Footwear and Apparel such that they
can search for and update retail product samples.

When you establish a vendor security model, you have to ensure that:

• Vendors are able to view the content of the project to which vendor is assigned to. They should not
be able to see content owned by group with security set to internal, unless that content is part of the
project to which vendor is assigned to.

• Vendors are part of a group with the group security level set to external.

• Vendors are able to search for and update sample revisions and requests.

You can set up a vendor security model for the following processes:

• Reviewing physical sample requests of retail materials.

• Reviewing product sample revisions of retail products.

• Reviewing product test requests of retail products.

Create a vendor

1. Navigate to and open the folder where you want to create the vendor, for example, your Newstuff
folder.

2. Click Add .

3. In the Add panel, from the Type list, select Vendor.

4. Specify the ID and Revision for the vendor or accept the default values.

5. Enter values for the following properties:

• Name

• Description

Retail Footwear and Apparel ─ Administration, Teamcenter 2412  7-1
© 2025 Siemens



• Address

• Phone

• Email

• Web Site

6. Click Add.

Set up a vendor security model for physical material sample
requests

Create a project and add users

1. Log on to the Teamcenter rich client as an administrator.

2. In the Project application, create a new project.

3. Add a project administrator and a database administrator to the project.

4. In the Organization application, create a group.

5. Enter a name for the group, and set the security for group as External.

6. Create and add internal and external users to the group.

7. Add both internal and external users to the project that you have created.

8. Designate both internal and external users as privileged users for the project.

Create the sample workflow to set up project based security

1. In Workflow Designer, select the Sample Workflow Process process template and edit it.

7. Managing vendors
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2. In the Handlers dialog box, with the Start folder selected, specify a name for the Action Handler,
and click Create to create a new workflow handler.

In this example, the new handler name is RETAIL_assign-to-project.

Create the sample workflow to set up project based security
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3. Select Sample Workflow Process and if the Set Stage to Available check box is not selected,
select it.

7. Managing vendors
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4. Click Yes to change the template stage to Available and make it available to all users.

Create the sample workflow to set up project based security
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Enable vendors to update physical sample requests

1. Create a new access control lists (ACL) to grant read access to the group that has its security set to
External.

2. For Ret0DeliverableShippingInfo, if the group is part of the project, make sure that Groups with
Security is set to External, and you apply the vendorwriteaccess ACL as shown in the following
graphic.

7. Managing vendors
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3. Create a new ACL to grant read access for the project team, and specify the name of the project
that you created for the vendor.

For example, in the following screen shot, the name of the ACL is VendorProjects and the name of
the project is VendorSecure.

4. Add a new Access Manager rule to give read access to the project team by applying the ACL created
in Step 3.

Enable vendors to update physical sample requests
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5. For Ret0MaterialPhysicalRequest, add an Access Manager rule within the In Project rule that you
created in Step 4. Make sure that Groups with Security is set to External, and you apply the
vendorwriteaccess ACL as shown in the following graphic.

7. Managing vendors
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6. Ensure that partners have a separate summary stylesheet for Ret0MaterialPhysicalRequest
configured with limited access. For more information about how to configure style sheets, see
Create a custom style sheet based on existing style sheet in the Teamcenter help.

7. For Ret0DeliverableAndShipInfo, add an Access Manager rule within the In Project rule that you
created in Step 4. Make sure that Groups with Security is set to External, and you apply the
vendorwriteaccess ACL as shown in the following graphic.

8. Make sure that Access Manager has rules restricting external users reading internal data. Such rules
are usually provided out of the box. However, you may have to create them if required.

Enable vendors to update physical sample requests
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Set up vendor security for product sample revisions

Create a project and add users

1. Log on to the Teamcenter rich client as an administrator.

2. In the Project application, create a new project.

3. Add a project administrator and a database administrator to the project.

4. In the Organization application, create a group.

5. Enter a name for the group, and set the security for group as External.

6. Create and add internal and external users to the group.

7. Add both internal and external users to the project that you have created.

8. Designate both internal and external users as privileged users for the project.

Specify the relation propagation rule

Note:

You must follow these steps to specify the relation propagation rules while setting up the vendor
security model for product sample revisions only. You need not set up the relation propagation
rules for the physical material sample requests vendor security model as they are provided out of
the box.

1. Open BMIDE and create a custom project that is dependent on the retail template.

7. Managing vendors
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2. From Extensions, right-click the project and choose Open Propagation Rules Editor.

3. Click Add to define a new propagation rule.

4. In the New Propagation Rule dialog box, do the following:

• Direction = Forward

• Source Business Object = Sample Revision

• Property Type = Relation

• Relation = Asset_Thumbnail_Rel

Specify the relation propagation rule
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• Destination Business Object = Dataset

• Propagation Group = Security Group I

• Action Condition = isTrue

• Traversal Condition = isTrue

• Propagation Style = Merge

• Make sure that the Background and Secured check boxes are selected.

• Click Apply.

5. Retaining all values specified in step 4, except the values for Relation, Destination Business
Object, and Propagation Group, create additional relation propagation rules using values specified
in the following table.

Relation Destination BO Propagation Group
Asset_Thumbnail_Rel Dataset Security Group II
Fnd0DerivedImageRel Dataset Security Group I
Fnd0DerivedImageRel Dataset Security Group II
Ret_File_Rel Dataset Security Group I
Ret_File_Rel Dataset Security Group II
Sample_Measurement_Rel SamplePomTable Security Group I
Sample_Measurement_Rel SamplePomTable Security Group II
Sample_Request_Rel POM_object Security Group I
Sample_Request_Rel POM_object Security Group II
Ret0_TechPack_Rel Dataset Security Group I
Ret0_TechPack_Rel Dataset Security Group II

6. Click OK to close the New Propagation Rule dialog box.

7. Package the custom project and deploy using TEM.

Create the sample workflow to set up project based security

1. In Workflow Designer, select the Sample Workflow Process process template and edit it.

7. Managing vendors
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2. In the Handlers dialog box, with the Start folder selected, specify a name for the Action Handler,
and click Create to create a new workflow handler.

In this example, the new handler name is RETAIL_assign-to-project.

Create the sample workflow to set up project based security
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3. Select Sample Workflow Process and if the Set Stage to Available check box is not selected,
select it.

7. Managing vendors
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4. Click Yes to change the template stage to Available and make it available to all users.

Create the sample workflow to set up project based security
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Enable vendors to update product sample revisions

1. Create a new ACL to grant read access to the group which has security set to External.

2. Give read access to SamplePomTable, SamplePointOfMeasureRow, ConstructionTable,
ConstructionDetail and GradeRule, and apply the ACL created in step 1 to the new access
manager rules.

7. Managing vendors
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Note:

These access manager rules must be placed before the In Project access manager rules.

3. Create new ACL to grant read access for the project team, and specify the name of the project that
your created for the vendor.

For example, in the screen shot below the name of the ACL is VendorProjects and the name of the
project is VendorSecure.

4. Add a new Access Manager rule to give read access to the project team by applying the ACL created
in Step 3.

Enable vendors to update product sample revisions
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5. Under the In Project node, add three more Access Manager rules to give read access to
SampleRevision, PointOfMeasure, and Dataset.

Note:

You must create these Access Manager rules under the In project node so that no other
SampleRevision, PointOfMeasure, or Dataset values are exposed to the external user.

7. Managing vendors
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6. Make sure that Access Manager has rules restricting external users reading internal data. Such rules
are usually provided out of the box. However, you may have to create them if required.

Create a new XML stylesheet dataset

Note:

You must follow these steps while setting up the vendor security model for product sample
revisions only.

To create a new vendor stylesheet dataset:

1. Create a new XML file for rendering the style sample, and save it in the
TC_ROOT\install\retail\StyleSheets directory as StyleSample_ExternalGrp.xml.

2. Go to TC_ROOT\install\retail\StyleSheets, and open the StyleSample.xml file.

Create a new XML stylesheet dataset
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3. Copy the content and paste it in the StyleSample_ExternalGrp.xml file.

4. Delete the Product section from the StyleSample_ExternalGrp.xml file.

5. Add this new style sheet to the input.txt file located at TC_ROOT\install\retail\StyleSheets. For
example, StyleSample_ExternalGrp, StyleSample_ExternalGrp.xml.

6. Run the following command to create the new XML style sheet dataset:

install_xml_stylesheet_datasets -u=Tc-admin-user -p= -g=group -input=TC_INSTALL_DIR/retail/
StyleSheets/input_vendor.txt -filepath=TC_INSTALL_DIR/retail/StyleSheets/ -replace

password

Set preferences to specify the stylesheet for rendering samples

Note:

You must follow these steps while setting up the vendor security model for product sample
revisions only.

1. Create a new XML preference file at TC_ROOT\install\retail.

2. Name the file as retail_externalGroup_preferences_merge.

3. Add the following context to the new preference file:

<?xml version="1.0" encoding="iso-8859-1"?>

<preferences version="10.0">

<category name="Retail Footwear and Apparel">

<category_description/>

<preference name="AWC_StyleSampleRevision.SUMMARYRENDERING"

type="String" array="false" disabled="false" protectionScope="User"

envEnabled="false">

<preference_description>Stylesheet to be used to render the

summary view of business object of type StyleSampleRevision.
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</preference_description>

<context name="Teamcenter">

<value>Awp0StyleSampleRevisionExternalGroupSummary</value>

</context>

</preference>

</category>

</preferences>

4. Save the xml file.

5. Run the following command to add the new user preference:

preferences_manager -u=<externalUserName> -p=<externalUserPwd> -g=<externalGroup>
-mode=import -scope=USER -action=MERGE -file=TC_INSTALL_DIR/retail/
retail_externalGroup_preferences_merge.xml

Note:

You must run the above command to set the user level preference for each external user
explicitly.

Set up a vendor security model for product test requests

Create a project and add users

1. Log on to the Teamcenter rich client as an administrator.

2. In the Project application, create a new project.

3. Add a project administrator and a database administrator to the project.

4. In the Organization application, create a group.

5. Enter a name for the group, and set the security for group as External.

6. Create and add internal and external users to the group.

7. Add both internal and external users to the project that you have created.

Create a project and add users
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8. Designate both internal and external users as privileged users for the project.

Specify the relation propagation rules for product test request revisions

1. Open BMIDE and create a custom project that is dependent on the retail template.

2. From Extensions, right-click the project and choose Open Propagation Rules Editor.

3. Click Add to define a new propagation rule.

4. In the New Propagation Rule dialog box, do the following:

• Direction = Forward
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• Source Business Object = RetailMatTestingRevision

• Property Type = Relation

• Relation = Asset_Thumbnail_Rel

• Destination Business Object = Dataset

• Propagation Group = Security Group I

• Action Condition = isTrue

• Traversal Condition = isTrue

• Propagation Style = Merge

• Ensure that the Background and Secured check boxes are selected.

• Click Apply.

5. Retaining all values specified in step 4, except the values for Relation, Destination Business
Object, and Propagation Group, create additional relation propagation rules by using the values
specified in the following table.

Relation Destination BO Propagation Group
Asset_Thumbnail_Rel Dataset Security Group II
Fnd0DerivedImageRel Dataset Security Group I
Fnd0DerivedImageRel Dataset Security Group II
Ret_File_Rel Dataset Security Group I
Ret_File_Rel Dataset Security Group II
Ret0MatTestResultsRel Dataset Security Group I
Ret0MatTestResultsRel Dataset Security Group II
Ret0MatTestTemplateRel Dataset Security Group I
Ret0MatTestTemplateRel Dataset Security Group II
Ret0_Brand_Rel Ret0Brand Security Group I
Ret0_Brand_Rel Ret0Brand Security Group II

6. Click OK to close the New Propagation Rule dialog box.

7. Package the custom project and deploy using TEM.

Create the sample workflow to set up project based security

1. In Workflow Designer, select the Sample Workflow Process process template and edit it.

Create the sample workflow to set up project based security
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2. In the Handlers dialog box, with the Start folder selected, specify a name for the Action Handler,
and click Create to create a new workflow handler.

In this example, the new handler name is RETAIL_assign-to-project.
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3. Select Sample Workflow Process and if the Set Stage to Available check box is not selected,
select it.

Create the sample workflow to set up project based security
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4. Click Yes to change the template stage to Available and make it available to all users.
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Enable vendors to update product test sample revisions

1. Create a new access control list (ACL) to grant read access to the group that has its security set to
External.

2. Create a new ACL to grant read access for the project team, and specify the name of the project
that you created for the vendor.

For example, here, the name of the ACL is VendorProjects and the name of the project is
TestProject001.

Enable vendors to update product test sample revisions
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3. Add a new Access Manager rule to provide read access to the project team by applying the ACL
created in Step 2.

4. Under the In Project node, add an Access Manager rule to provide read access to
RetailMatTestingRevision.

5. Make sure that Access Manager has rules restricting external users reading internal data. Such rules
are usually provided out of the box. However, you may have to create them if required.
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Delete a vendor from the database

1. Search for the vendor that you want to delete.

2. Select the vendor and click Delete .

3. In the Delete message box, click Yes to confirm deletion.

Delete a vendor from the database
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8. Configuring image compression
Compressing images to load them quickly

Image files are used in Retail Footwear and Apparel for tiles, preview images, thumbnails, breadcrumbs,
and so on. Image resolution is the clarity with which you can view the image with distinct boundaries.
The resolution of the image depends on the number of pixels; more pixels correspond to more clarity,
but also increases the size of the image. Large images take a lot of time for rendering and viewing.

To render images not only quickly but also with high clarity, you can compress them and reduce their
sizes without distorting the quality. You can manage the quality, sharpness, color, and accuracy of the
images with lower resolutions. You can generate low, medium, and high resolutions of the original
uploaded image while maintaining their aspect ratio. You can also define custom resolutions for the
images.

Configure image compression

You can compress images used for tiles, preview images, thumbnails, breadcrumbs, and so on. This
reduces their size without distorting the quality. Following are the prerequisites for configuring image
resolution:

• Teamcenter Visualization with Mockup and Convert & Print features.

• Dispatcher Server and Dispatcher Client components under Teamcenter Enterprise Knowledge
Foundation are installed using Teamcenter Environment Manager.

• Image translator installed using the Teamcenter Environment Manager.

To compress images:

1. Make sure that the image compression feature is enabled using the
TC_image_compression_enabled preference in Teamcenter rich client. The default value for this
feature is set to true.

2. Make sure that the TC_image_compression_types preference in Teamcenter rich client is enabled.

The out-of-the-box (OOTB) values are:

• 64px::Low

• 300px::Medium

• 600px::High
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You can also define custom values for images, such as 1200px::LARGE or 2800px::EXTRALARGE.

These values are for the height of the translated image, and the appropriate width is automatically
adjusted by the image translator based on the aspect ratio of the original image.

3. To specify the default image to be used for scaling across Active Workspace application, set the
value for the AWC_default_image_resolution preference. The default OOTB value is Medium.

Note:

The values for image resolution are not case sensitive.
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8-2  Retail Footwear and Apparel ─ Administration, Teamcenter 2412
© 2025 Siemens



9. Setting up custom dimensions
Adding dimensions in the system

A technical designer defines the dimensions for the raw materials or components that will be used for
creating the retail product. For example, they specify the different colors for each material, the different
sizes of each BOM item, and different finishes, length, and vendors for each retail material used in the
product.

A list of dimensions is available out of the box (as an LOV). Based on your business needs, you may need
additional custom dimensions. In this case, you first create the custom dimension in the system. Next,
you add these custom dimensions to the existing LOVs. The custom dimensions are now available to
the technical designer.

You can also include these custom dimensions for dimension mapping. To do this, use the
RetailProductRevision_DimensionsMap preference.

Create and add custom dimensions to key LOVs

Based on your business needs, you may need additional custom dimensions. You must first create the
custom dimension in the system and then modify existing LOV to add the new custom dimensions to the
definition of the existing LOV.

Create custom dimensions

1. Log on to Teamcenter as an administrator and go to Classification Admin→Key LOVs.

2. From the Existing Key LOV Lists, select the Dimension Type, to which you have to add the custom
dimensions.

3. Click Add Entry to add a new dimension.

4. Enter a name for the dimension such as Sizes.

5. Click Save.
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Edit the key LOVs to add the custom dimensions

1. In Teamcenter, go to Classification Admin→Key LOVs.

2. From the Existing Key LOV Lists, select the required key LOV, to which you want to add the custom
dimensions.

3. Click Edit Current Instance.

4. In the Key field, enter the ID that corresponds to the key LOV, and in the Value filed, enter the
name of the custom dimension.

9. Setting up custom dimensions
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5. Click Save.

Enable dimension mapping for custom dimensions

To perform dimension mapping using custom dimensions, set the
RetailProductRevision_DimensionsMap preference. To do this:

1. Choose Edit→Options.

2. In the Preferences List, search for the RetailProductRevision_DimensionsMap preference.

3. Edit the RetailProductRevision_DimensionsMap preference to add the custom dimension under
Values and click Save.

Enable dimension mapping for custom dimensions
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4. Click Close to close the Options dialog box.

Specify dimensions for new or modified key LOVs

If you do not use the classification that is provided out of the box, or if you use existing classification
with some modifications to the key LOVs, you may need to add new dimensions for retail products. For
example you want to use new classifications with new key LOVs, or existing key LOVs, or you want to
modify existing classifications with new or modified key LOVs.

When specifying the dimensions for the retail product using the Manage Dimension command, the
technical designer will see the new dimensions and can define their values accordingly.

To specify dimensions for the new LOVs, do the following:

1. Ensure that the classification that you want to use is already defined. For more information, see
Classification in the Teamcenter help.

2. Define a new key LOV which contains the required list of dimensions such as vendor or color.

3. Copy the classification class ID and the key LOV ID. You will need these values when you set the
Retail_AssetVariantOptions preference.

4. Choose Edit→Options, and in the Options dialog box, click Search.
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5. In Preferences List, in the Search on Keywords box, enter keywords to search for the
Retail_AssetVariantOptions preference and double-click to view it.

6. In the Definition tab, under Values, click Edit to add enter the new classification class ID and the
key LOV ID in the specified format. For example <classification ID>:-<key LOV ID>

7. Click Save.

Specify dimensions for new or modified key LOVs

Retail Footwear and Apparel ─ Administration, Teamcenter 2412  9-5
© 2025 Siemens



9. Setting up custom dimensions

9-6  Retail Footwear and Apparel ─ Administration, Teamcenter 2412
© 2025 Siemens



10. Configuring Adobe CC integration for
2D CAD objects
You can configure Adobe CC integration for 2D CAD objects such that the .ai and .xml files are
automatically included along with the 2D CAD objects that you attach to the retail product. To do this:

1. Create the template in BMIDE and make the schema changes.

a. In BMIDE, choose File→New→New Business Modeler IDE Template Project.

b. In the Business Modeler IDE Template Project dialog box, enter values for Prefix, Template
Name, Template Display Name, and Template description.

c. In Dependent Template directory, click Browse to specify the directory where the data
model template XML files are stored.

Normally, the template files are in the Teamcenter install location \TR\bmide\templates.

d. Click Finish.

e. Browse to the location of the AdobeIntegration.xml and AdobeIntegrationen_US.xml files.

f. Add the AdobeIntegration.xml file in the extensions folder and the
AdobeIntegrationen_US.xml file in the lang folder.

g. Update the master.xml file to include AdobeIntegration.xml as shown.

h. Reload the data model and deploy your BMIDE changes.

2. Import the templates in Teamcenter

a. Log on to Teamcenter as a dba user.

b. Choose Tools→Import→From PLMXML.
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c. Browse to select the Adobe_Integration_Template.xml file.

d. In the PLMXML_Import dialog box, make sure that the Transfer Model Name is set to
ConfigurationDataImportDefault.

e. Click OK to import the template.

3. Modify the stylesheets in Teamcenter

a. Log on to Teamcenter as a dba user.

b. Search for the Ret02CADCreate dataset.

c. In the Viewer tab, edit the dataset to add the DocumentSubject property as shown in the
following graphic.

d. Search for the Ret02DCADRevisionSummary file.

10. Configuring Adobe CC integration for 2D CAD objects
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e. In the Viewer tab, edit the file as shown in the following graphic.

4. Submit the imported templates to the TCM Release Process workflow.

a. Log on to the Teamcenter rich client as a Retail user.

b. Search for the Adobe Integration Apparel Template.

c. Select the Apparel AI Template and Apparel XML Template and submit them to the TCM
Release Process workflow.

Retail Footwear and Apparel ─ Administration, Teamcenter 2412  10-3
© 2025 Siemens



d. Search for the Adobe Integration Footwear Template.

e. Select the Footwear AI Template and Footwear XML Template and submit them to the TCM
Release Process workflow.

f. Make sure that both the templates are released through the TCM Release Process workflow.

Now, when users attach 2D CAD objects to the retail product, and they select an option from the
Document Subject list, the .ai and .xml files are automatically attached along with the 2D CAD objects.
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